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1 Introduction

● Safety precautions

● HP Start-Up Kit

● Your printer's documentation

● Using this guide

● The printer's main features

● The printer's main components

● The front panel

● Printer software

● The printer's internal prints
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Safety precautions
The following precautions ensure the proper use of the printer and prevent the printer from being
damaged. Follow these precautions at all times.

● Use the power supply voltage specified on the nameplate. Avoid overloading the printer's electrical
outlet with multiple devices.

● Ensure the printer is well-grounded. Failure to ground the printer may result in electrical shock,
fireand susceptibility to electromagnetic interference.

● Do not disassemble or repair the printer yourself. Contact your local HP Service Representative
for service, see Contact HP Support on page 154.

● Use only the electrical cord supplied by HP with the printer. Do not damage, cut or repair the power
cord. A damaged power cord has risk of fire and electric shock. Replace a damaged power cord
with an HP-approved power cord.

● Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of
the printer. Doing so may cause fire, electric shock or other serious hazards.

● Power off the printer and unplug the power cable from the power outlet in any of the following cases:

◦ When placing your hands inside the printer

◦ If there is smoke or an unusual smell coming from the printer

◦ If the printer is making an unusual noise not heard during normal operation

◦ A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal
parts of the printer

◦ During a thunderstorm

◦ During a power failure

HP Start-Up Kit
The HP Start-Up Kit is the CD that comes with your printer; it contains the printer's software.

Your printer's documentation
You can read about how to use your printer in Using your printer and the Quick reference guide. The
most complete source of information is Using your printer, which is available from http://www.hp.com/
go/z3200/manuals/. The Quick reference guide contains the most commonly-needed information, and
is provided as a printed manual with your printer.

Using this guide
Using your printer is organized into the following chapters.

Introduction
This chapter provides a brief introduction to the printer and its documentation for new users.
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Use and maintenance
These chapters help you carry out normal printer procedures and include the following topics.

● Installing the software on page 9

● Personalizing the printer on page 17

● Paper handling on page 22

● Printing on page 42

● Color management on page 53

● Retrieving printer usage information on page 78

● Handling ink cartridges and printheads on page 81

● Maintaining the printer on page 92

Troubleshooting
These chapters help you solve problems that may occur while printing and include the following topics.

● Troubleshooting paper issues on page 111

● Troubleshooting print-quality issues on page 120

● Troubleshooting ink cartridge and printhead issues on page 137

● Troubleshooting general printer issues on page 145

● Front-panel error messages on page 150

Support, accessories and specifications
These chapters contain reference information, including HP customer care, the specifications of the
printer and the part numbers of paper types, ink supplies and accessories.

Glossary
This chapter contains definitions of printing and HP terms used in this documentation.

Index
In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and Cautions
The following symbols are used in this manual to ensure the proper use of the printer and to prevent
the printer from being damaged. Follow the instructions marked with these symbols.

WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal
injury or death.

CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury
or damage to the product.
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The printer's main features
Your printer is a color inkjet printer designed for printing high-quality images on paper up to 44 in (1.12
m) wide. Some major features of the printer are shown below:

● Print resolution of up to 2400 × 1200 optimized dpi, from a 600 × 600 dpi input, using the Best
print-quality option, the Maximum Detail option and photo paper

● The HP Printer Utility, see Access the HP Printer Utility on page 19, provides an easy-to-use
interface including:

◦ A single point for color control

◦ Import, creation and management of paper presets

◦ Calibration of printer and display

◦ Access to the online HP Printing Knowledge Center

● Accurate and consistent color reproduction with automatic color calibration and profiling

● Twelve-ink system providing a wide color range on matte fine art papers and glossy photo papers
for photographic and graphic arts prints and complete coverage of ISO and SWOP gamuts for color
accuracy in pre-press applications

● Embedded Spectrophotometer for consistent and accurate color, even with paper and environment
changes, and easy creation of paper presets, see HP Embedded Spectrophotometer
on page 58

● Ink and paper usage information available from the Web from the Embedded Web Server, see
Access the Embedded Web Server on page 19

● Paper flexibility and automatic easy load, see Paper handling on page 22, with information and
paper presets accessible from the front panel and from the HP Printer Utility

The printer's main components
The following front and rear views of the printer illustrate the main components.
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Front view

1. Ink cartridge

2. Ink cartridge slots

3. Blue lever

4. Transparent window

5. Front panel

6. Printhead carriage

7. Printhead

8. Output tray

9. Paper alignment lines

10. Basket

Rear view

1. Spindle

2. Spindle holders

3. Quick Reference Guide holder

4. Sockets for communication cables and optional accessories
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5. Hard power switch

6. Power cord plug in

7. Paper feeder

The front panel
Your printer's front panel is located on the front of the printer, in the center. It has the following important
functions:

● Assists you in troubleshooting issues

● Is used to perform certain procedures, such as cutting and unloading paper

● Displays helpful animations to guide you through procedures

● Displays up-to-date information about the status of the printer, such as the ink cartridges, the
printheads, the paper and the print jobs

● Displays warning and error messages, when appropriate, along with audio alerts to call attention
to a warning or message

● Can be used to change the values of printer settings and thus change the operation of the printer.
However, settings in the front panel are overridden by settings in the printer drivers, see Installing
the software on page 9.

The front panel has the following components:

1. Direct access keys:

● First key: View ink levels, see Check ink cartridge status on page 82

● Second key: View loaded paper, see View information about the paper on page 34

● Third key: Unload paper, see Unload a roll on page 29 and Unload a single sheet
on page 33

● Fourth key: Form feed and cut, see Feed and cut the paper on page 40

2. Menu key - Press to return to the main menu of the front-panel display. If you are already on the
main menu it will display the status screen.

3. OK key - To confirm an action while in a procedure or interaction. To enter in a submenu in the
menu. To select a value when given an option.

4. Back key - To go to the previous step in a procedure or interaction. To go to the upper level, or
leave the option in the menu, or when given an option.

5. Down key - To go down in a menu or option, or to decrease a value, for example when configuring
the front-panel display contrast or the IP address.
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6. Up key - To go up in a menu or option, or to increase a value, for example when configuring the
front-panel display contrast or the IP address.

7. Cancel key - To abort a procedure or interaction.

8. Power key - To turn the printer off or on, it also has a light to indicate the printer's status. If the
power key light is off the device is off. If the power key light is blinking green, the device is starting
up. If the power key light is green on, the device is on. If the power key light is amber on, the device
is in standby. If the power key light is blinking amber, the device needs attention.

9. LED light - Indicates the printer's status. If the LED light is solid green, the device is ready. If it is
flashing green, the device is busy. If it is solid amber, there is a system error. If it is flashing amber,
the printer needs attention.

10. Front-panel display - Displays error, warnings and information on using your printer.

To highlight an item in the front-panel display, press the Up or Down key until the item is highlighted.

To select an item in the front-panel display, first highlight it and then press the OK key.

When this guide shows a series of front-panel display items like this: Item1 > Item2 > Item3, it means
that you should select Item1, then select Item2, then select Item3.

Information about specific uses of the front panel can be found throughout this guide.

Printer software
The following software is provided with your printer:

● The PCL3 raster printer driver

● The HP Printer Utility, see Access the HP Printer Utility on page 19, allows you to:

◦ Manage the printer including color with the HP Color Center

◦ View the status of the ink cartridges, the printheads and the paper

◦ View job accounting information, see Retrieving printer usage information on page 78

◦ Update the printer's firmware, see Update the firmware on page 98

◦ Access the HP Knowledge Center

◦ Change various printer settings (in the Settings tab)

◦ Perform calibrations and troubleshooting

● The Embedded Web Server runs in the printer and enables you to use a Web browser on any
computer to check ink levels and printer status, see Access the Embedded Web Server
on page 19

The printer's internal prints
The internal prints give various kinds of information about your printer. They can be requested from the
front panel without using a computer.

Before requesting any internal print, make sure that paper is loaded (roll or sheet) and that the front
panel displays the Ready message. The loaded paper should be at least A3 landscape (16.53 in or 42
cm wide); otherwise the print may be clipped.
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To print any internal print, select the Internal Prints menu icon , then select the internal print you
want. The following internal prints are available.

● Menu map: shows details of all the front-panel display menus

● Configuration: shows all the current front-panel display settings

● Usage report: shows estimates of the total number of prints, number of prints by paper type, number
of prints by print-quality option and total amount of ink used per color (the accuracy of these
estimates is not guaranteed)

● Service information: provides information needed by service engineers
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2 Installing the software

● Choose which connection method to use

● Connect to a network (Windows)

● Connect directly to a computer (Windows)

● Uninstall the printer software (Windows)

● Connect to a network (Mac OS)

● Connect directly to a computer (Mac OS)

● Uninstall the printer software (Mac OS)
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Choose which connection method to use
The following methods can be used to connect your printer.

Connection type Speed Cable length Other factors

Fast Ethernet Fast; varies according to
network traffic

Long (100 m=328 ft) Requires extra equipment (switches)

Jetdirect print server
(optional accessory)

Moderate; varies
according to network
traffic

Long (100 m=328 ft) Requires extra equipment (switches)

Provides additional features

See http://www.hp.com/go/jetdirect/ for
more details

USB 2.0 Very fast Short (5 m=16 ft)

NOTE: The speed of any network connection depends on all components used in the network, which
can include network interface cards, hubs, routers, switches and cables. If any one of these components
cannot operate at high speed, you will have a low-speed connection. The speed of your network
connection can also be affected by the total amount of traffic from other devices on the network.

Connect to a network (Windows)
Before you begin, check your equipment:

● The printer should be set up and on.

● The Ethernet hub or router should be on and functioning correctly.

● All computers on the network should be on and connected to the network.

● The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer:

1. Make a note of the IP address from the status screen on the printer's front panel (192.168.1.1 in
this example):

2. Insert the HP Start-Up Kit CD into your computer. If the CD does not start automatically, run the
autorun.exe program in the root folder of the CD.

3. Click Express Network Install. The printer driver and the HP Printer Utility will be installed.

4. Follow the instructions on your screen to set up the printer.

The configuration program looks for printers connected to your network. When the search is
complete, a list of printers appears. Identify your printer by its IP address and select it from the list.
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If your computer fails to find any printers on the network, the Printer Not Found window is displayed,
which helps you to try to find your printer. If you have a firewall in operation; you may have to disable it
temporarily in order to find the printer. You also have the options of searching for the printer by its URL,
IP address or MAC address.

NOTE: Although IPv6 is supported, automatic installation of the printer driver is not guaranteed to work
with it, so you may need to use the standard Windows Add Printer Wizard to install the driver.

Connect directly to a computer (Windows)
You can connect your printer directly to a computer without going through a network, by using the
printer's built-in USB 2.0 socket.

TIP: A USB connection may be faster than a network connection, but the cable is limited in length and
it is more difficult to share the printer.

1. Do not connect the computer to the printer yet. You must first install the printer driver software
on the computer, as follows.

2. Insert the HP Start-Up Kit CD into your CD drive. If the CD does not start automatically, run the
autorun.exe program in the root folder of the CD.

3. Click Custom Install. The printer driver and the HP Printer Utility will be installed.

4. You may see a message warning that the installer will have to communicate through the Windows
Firewall to search for printers on the network. As you intend to set up a USB connection, select
Continue installation without searching the network and click Next.

5. Follow the instructions on your screen to set up the printer. The following notes help you to
understand the screens and make appropriate choices.

● When asked how the printer is connected, select USB cable.

● If you would like to share the printer with other people connected to your network, press
the Printer Properties button in the Ready to Install window, set Printer Name to the name
under which the printer will be shared, then set Shared to Yes.

● When prompted to do so, connect your computer to the printer with a certified USB cable.
Ensure that the printer is turned on.

NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables
certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this
printer.

Printer sharing considerations
● The HP Printer Utility must be installed on a computer before it can be used from that computer.

● Any other people sharing your directly connected printer will be able to send print jobs, but will not
be able to receive information from the printer—which affects printer alerts, printer status reports,
paper management, printer administration and troubleshooting.

● Any other people sharing your directly connected printer will be unable to use the printer's own
print preview facility, although the application's print preview will still be available. See Preview a
print on page 46.

TIP: The best way to share the printer over a network is to connect the printer not to any computer,
but to the network. See Connect to a network (Windows) on page 10.

ENWW Connect directly to a computer (Windows) 11

So
ftw

ar
e 

in
st

al
la

tio
n

http://www.usb.org/


Uninstall the printer software (Windows)
1. Insert the HP Start-Up Kit CD into your CD drive. If the CD does not start automatically, run the

autorun.exe program in the root folder of the CD.

2. Select Modify Installation and follow the instructions on your screen to uninstall the printer
software.

Connect to a network (Mac OS)
You can connect your printer to a network under Mac OS X by using the following methods:

● Bonjour/Rendezvous

● TCP/IP

NOTE: The printer does not support AppleTalk.

Before you begin, check your equipment:

● The printer should be set up and on.

● The Ethernet hub or router should be on and functioning correctly.

● All computers on the network should be on and connected to the network.

● The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer.

Bonjour/Rendezvous connection
1.

Go to your printer's front panel and select the Connectivity menu icon , then Fast Ethernet
> View configuration. Note the mDNS service name of your printer.

2. Insert the HP Start-Up Kit CD into your CD drive.

3. Open the CD icon on your desktop.

4. Open the Mac OS X HP Designjet Installer icon.

5. Follow the instructions on your screen. You are recommended to use the Easy Install option.
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6. The printer software is installed, including the printer driver and the HP Printer Utility.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set
up a connection to your printer. Follow the instructions on your screen.

8. When you reach the Select Printer screen, look for your printer's mDNS service name (which you
noted in step 1) in the Printer Name column.

● If you find the right printer name, scroll sideways to see the Connection Type column, and
check that it shows Bonjour/Rendezvous. Then highlight that line. Otherwise, continue
searching further down the list.

● If you cannot find your printer name with a Bonjour/Rendezvous connection type, check the
box My printer is not in the list.

Click Continue.

9. Continue following the instructions on the screen. When you reach the Printer Queue Created
screen, click Quit to exit, or Create New Queue if you want to connect another printer to the
network.

10. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
CD.
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TCP/IP connection
1. Go to your printer's front panel and press the Menu key until you see the status screen.

Note the URL of your printer (http://XXXX11 in this example).

2. Insert the HP Start-Up Kit CD into your CD drive.

3. Open the CD icon on your desktop.

4. Open the Mac OS X HP Designjet Installer icon.

5. Follow the instructions on your screen. You are recommended to use the Easy Install option.

6. The printer software is installed, including the printer driver and the HP Printer Utility.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set
up a connection to your printer. Follow the instructions on your screen.

8. When you reach the Select Printer screen, look for your printer's URL (which you noted in step 1)
in the Printer Name column.

● If you find the right printer name, scroll sideways to see the Connection Type column, and
check that it shows IP Printing. Then highlight that line. Otherwise, continue searching further
down the list.

● If you cannot find your printer name with an IP Printing connection type, check the box My
printer is not in the list.

Click Continue.
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9. Continue following the instructions on the screen. When you reach the Printer Queue Created
screen, click Quit to exit, or Create New Queue if you want to connect another printer to the
network.

10. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
CD.

Connect directly to a computer (Mac OS)
You can connect your printer directly to a computer without going through a network, by using the
printer's built-in USB 2.0 socket.

1. Make sure the printer is either turned off or disconnected from the computer.

2. Insert the HP Start-Up Kit CD into your CD drive.

3. Open the CD icon on your desktop.

4. Open the Mac OS X HP Designjet Installer icon.

5. Follow the instructions on your screen. You are recommended to use the Easy Install option.

6. The printer software is installed, including the printer driver and the HP Printer Utility.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set
up a connection to your printer.

8. Make sure that the printer is turned on and connected to the computer with a certified USB cable.

NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables
certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this printer.

9. In the HP Printer Setup Assistant, click Continue.

10. In the list of printers that appears, select the entry that uses the connection type USB, and click
Continue.

11. The following screen displays information about your printer's installation, where the name of the
printer can be modified. Make any changes you wish to make, and click Continue.
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12. Your printer is now connected. In the Printer Queue Created screen, click Quit to exit, or Create
New Queue if you want to connect another printer.

13. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
CD.

Sharing the printer
If your computer is connected to a network, you can make your directly connected printer available to
other computers on the same network.

1. Double-click the System Preferences icon on the Dock menu bar on your desktop.

2. Enable printer sharing by going to Sharing > Services > Printer Sharing.

3. Your printer now automatically appears in the list of shared printers displayed by any other
computer running Mac OS and connected to your local network.

Any other people wishing to share your printer must install the printer software on their own computers.

Anyone sharing your printer will be able to send print jobs, but will not be able to receive information
from the printer—which affects printer alerts, printer status reports, paper management, printer
administration and troubleshooting.

You may find that sharing your directly connected printer with other users will slow down your computer
unacceptably.

TIP: The best way to share the printer over a network is to connect the printer not to any computer,
but to the network. See Connect to a network (Mac OS) on page 12.

Uninstall the printer software (Mac OS)
1. Insert the HP Start-Up Kit CD into your CD drive.

2. Open the CD icon on your desktop.

3. Open the Mac OS X HP Designjet Installer icon.

4. Select Uninstall, and follow the instructions on your screen to uninstall the printer software.

To delete the print queue:

● Under Mac OS X 10.5: from the system preferences, select the Print & Fax dialog. Select the name
of the printer and click the – button.

● Under Mac OS X 10.4 there are two ways of deleting the print queue:

◦ from the system preferences, select the Printing pane of the Print & Fax dialog. Select the
name of the printer and click the – button.

◦ from the Print Setup utility, select the name of the printer and click the Delete icon.
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3 Personalizing the printer

● Turn printer on and off

● Change the language of the front-panel display

● Access the HP Printer Utility

● Access the Embedded Web Server

● Change the language of the HP Printer Utility

● Change the language of the Embedded Web Server

● Change the sleep mode setting

● Turn the buzzer on and off

● Change the front-panel display contrast

● Change the units of measurement

● Configure network settings
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Turn printer on and off
TIP: The printer can be left powered on without wasting energy. Leaving it on improves response time
and overall system reliability. When the printer has not been used for a certain period of time (the default
time is determined by Energy Star), it saves power by going into sleep mode. However, any interaction
with the printer's front-panel display returns it to active mode, and it can resume printing immediately.
To change the sleep mode time, see Change the sleep mode setting on page 20.

NOTE: In sleep mode, the printer wakes up from time to time to do maintenance service to the
printheads. This avoids the need of doing long preparation after long idle periods.

The printer has three levels of power consumption.

● Plugged in: the power cord is plugged into the back of the printer

● Switched on: the switch at the back of the printer is in the on position

● Powered on: the Power key on the front panel shows a green light

If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to
use the Power key on the front panel.

However, if you plan to store the printer indefinitely or the Power key does not seem to work, you are
recommended to power it off using the Power key, and then also switch off the power switch at the rear.

To turn it back on, use the power switch at the rear.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare
the printheads. Preparing the printheads takes about one minute and 15 seconds. However, if the printer
has been off for six weeks or more, preparing the printheads could take up to 60 minutes.

TIP: It is strongly recommended to leave the printer powered on or in sleep mode to avoid wasting ink
and time.
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Change the language of the front-panel display
There are two possible ways to change the language of the front-panel menus and messages.

●
If you can understand the current front-panel display language, select the Setup menu icon ,
then Front panel options > Select language.

● If you cannot understand the current front-panel display language, start with the printer powered
off. At the front panel, press the OK key and hold it down. While holding the OK key down, press
the Power key and hold it down. Continue to hold down both keys until the green light on the right
side of the front-panel display starts flashing, and then release both keys. You can expect a delay
of about one second. If the green light starts flashing without any delay, you may need to start
again.

Whichever method you used, the language selection menu should now appear on the front-panel
display. Highlight your preferred language with the Up and Down keys, then press the OK key.

When you have selected your preferred language, turn off the printer with the Power key and then turn
it on again. The front panel will appear in the selected language.

Access the HP Printer Utility
The HP Printer Utility enables you to manage your printer from a computer with a USB connection and
TCP/IP.

● Under Windows, start the HP Printer Utility from your desktop shortcut or from Start > All
Programs > Hewlett-Packard > HP Printer Utility > HP Printer Utility. This launches the HP
Printer Utility showing the printers installed in the Printers and Faxes window.

● Under Mac OS, launch the HP Printer Utility from your dock shortcut or by selecting
STARTUP_DISK > Library > Printers > hp > Utilities > HP Printer Utility. This launches the HP
Printer Utility Printer Selector, showing the printers installed in the Printer Setup Utility (Mac OS X
10.4) or Print & Fax (Mac OS X 10.5 or later).

Select your printer and click Select. This launches the HP Printer Utility.

If you have followed these instructions but failed to get through to the HP Printer Utility, see Cannot
access the HP Printer Utility on page 147.

Access the Embedded Web Server
The Embedded Web Server enables you to manage your printer remotely using an ordinary Web
browser running on any computer.

NOTE: To use the Embedded Web Server, you must have a TCP/IP connection to your printer.

The following browsers are known to be compatible with the Embedded Web Server:

● Internet Explorer 6 or later for Windows

● Netscape Navigator 6.01 or later

● Mozilla 1.5 or later

● Mozilla Firefox 1.0 or later

● Safari 2 or later for Mac OS
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To access the Embedded Web Server on any computer, open your Web browser and give the address
of your printer. You can find out the address of your printer (starting with http:) from the front-panel
display, by looking at the status screen.

If you have followed these instructions but failed to get through to the Embedded Web Server, see
Cannot access the Embedded Web Server on page 147.

Change the language of the HP Printer Utility
The HP Printer Utility can work in the following languages: English, Portuguese, Spanish, Catalan,
French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese.

● Under Windows, select Tools > Set Language and select a language from the list.

● Under Mac OS, the language is changed as for any other application. In System Preferences
select International and re-launch the application.

Change the language of the Embedded Web Server
The Embedded Web Server can work in the following languages: English, Portuguese, Spanish,
Catalan, French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and
Japanese. It uses whichever language you have specified in your Web browser's options. If you have
specified a language that it cannot support, it works in English.

To change the language, you must change your Web browser's language setting. For example, in
Internet Explorer version 6, go to the Tools menu and select Internet Options, Languages. Then
ensure that the language you want is at the top of the list in the dialog box.

To complete the change, you must close and reopen your Web browser.

Change the sleep mode setting
If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep
mode to save power. To change the time the printer waits before it goes into sleep mode, go to the front

panel and select the Setup menu icon , then Advanced > Sleep mode wait time. Highlight the
wait time you want and then press the OK key. You can set the time to 30, 60, 120, 150, 180, 210 or
240 minutes.

Turn the buzzer on and off

To turn the printer's buzzer on or off, go to the front panel and select the Setup menu icon , then
Front panel options > Enable buzzer, highlight on or off and press the OK key. The default buzzer is
set to on.
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Change the front-panel display contrast
To change the contrast of the front-panel display, go to the front panel and select the Setup menu icon

, then Front panel options > Select display contrast, and enter a value using the Up or Down
key. Press the OK key to set the value. The default contrast is set to 50.

Change the units of measurement
To change the units of measurement in the front-panel display, go to the front panel and select the Setup

menu icon , then Advanced > Select units, and select English or Metric. By default the units are
set to metric.

Configure network settings
To configure the network settings from the HP Printer Utility for Windows, select Settings tab > Network
Settings. From the HP Printer Utility for Mac OS, select Network Settings in the Configuration group.
You can view and configure the following network settings.

● IP Configuration method: specify the way to set an IP address between BOOTP, DHCP, Auto IP
and Manual

● Host name: specify an IP name for the network device, the name may contain up to 32 ASCII
characters

● IP address: specify the IP address on the print server, duplicate IP addresses on a TCP/IP network
are not allowed

NOTE: If you change the current IP address and click Apply, the browser loses the current
connection to the print server because it is pointing to the old address. To reconnect, browse to
the new IP address.

● Subnet mask: specify a subnet mask, which is a 32-bit number applied to an IP address to
determine which bits specify the network and subnet and which bits uniquely specify the node

● Default gateway: specify the IP address of a router or computer that is used to connect to other
networks or sub-networks, if none exist, use the IP address of the computer or the IP address of
the print server

● Domain name: specify the name of the DNS domain that the print server resides in, for example,
support.hp.com, note that it does not include the host name; it is not the fully qualified domain
name, such as printer1.support.hp.com

● Idle timeout: specify the number of seconds that an idle connection is allowed to remain open,
270 is the default value, if set to zero, the timeout is disabled and TCP/IP connections remain open
until closed by the other node (such as a workstation) on the network

● Default IP: specify the IP address to use when the print server is unable to obtain an IP address
from the network when powered on or when reconfigured to use BOOTP or DHCP

● Send DHCP requests: specify whether DHCP requests are transmitted when a legacy default IP
address or a default Auto IP is assigned

To configure the same network settings from the front panel, select the Connectivity menu icon ,
then Fast Ethernet > Modify configuration.
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4 Paper handling

● General advice

● Load a roll onto the spindle

● Load a roll into the printer

● Unload a roll

● Load a single sheet

● Unload a single sheet

● View information about the paper

● Paper presets

● Print on loaded paper

● Move the paper

● Maintain the paper

● Change the drying time

● Turn the automatic cutter on and off

● Feed and cut the paper
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General advice
TIP: Before starting a paper loading process, make sure you have enough room around the printer,
both in front and behind.

CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

NOTE: All paper must be 11 inches (28 cm) or longer. A4 and US Letter paper cannot be loaded
landscape.

TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

CAUTION: Keep the basket closed throughout the loading process.

Load a roll onto the spindle
CAUTION: Ensure the sheet tray is closed.
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1. Remove the right-hand end of the spindle from the printer, then the other end.

WARNING! Do not insert your fingers into the spindle supports during the removal process.

2. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to
mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper
stop from the end of the spindle.

3. If your roll has a three-inch cardboard core, ensure that the core adaptors supplied with the printer
have been installed.

4. If the roll is long, rest the spindle horizontally on a table and load the roll on the table.
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TIP: You may need two people to handle a large roll.

5. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not,
remove the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the
spindle showing the correct orientation.

NOTE: From the back of the printer, the blue stop is fitted onto the right-hand end of the spindle.

Ensure both ends of the roll are as close to the spindle stops as possible.

6. Put the blue paper stop onto the open end of the spindle, and push it towards the end of the roll.

7. Ensure the blue paper stop is pushed in as far as it goes, until both ends are against the stops.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls
of different paper types on different spindles. Extra spindles are available for purchase, see
Accessories on page 101.

Load a roll into the printer
There are two ways to load a roll. The easy loading procedure is recommended.

To start these procedures you must have a roll loaded on the spindle. See Load a roll onto the
spindle on page 23.
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Easy loading procedure
1. Standing behind the printer, rest the spindle's black end on the left side roll holder. Do not put the

end completely into the roll holder.

2. Rest the blue end of the spindle on the right side roll holder.

3. With both hands, push the spindle into both roll holders at the same time. The spindle snaps in
place.
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4. If the edge of the roll is torn (sometimes due to tape used to hold the end of the roll) or not straight,
pull the paper slightly beyond the cutting groove and use a cutter to cut a straight edge.

TIP: Cut the paper as straight as possible, as uneven paper does not load correctly.

5. Insert the edge of the paper into the feeder.

CAUTION: Do not push your fingers inside the printer's paper path.

6. Roll the spindle into the feeder until you feel resistance. The printer detects the paper and feeds it
automatically into the printer.

7. Once the paper is fed into the printer, the front-panel display asks whether you are loading a roll
or a sheet. Select Roll with the Up and Down keys and press OK.
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8. Select your paper category and type.

TIP: If you have loaded a paper type whose name does not appear in the paper list, see The
paper type is not in the driver on page 113.

9. The printer checks the alignment and measures the width. It cuts a strip off the leading edge of
glossy or satin paper to ensure perfect quality; other paper types are not cut.

10. Look at the front panel; you may find some instructions there.

11. When the roll is aligned, the front panel displays the Ready message and the printer is ready to
print. If the roll is not aligned, follow the instructions on the front-panel display.

12. If the paper is loose on the roll, lightly rewind from the end of the spindle until tight.

NOTE: If you have an unexpected issue at any stage of the paper loading process, see The paper
cannot be loaded successfully on page 112.

TIP: When prints fall into the basket, they can be torn or marked by ink from other prints. To avoid this,
catch your prints as they are cut from the roll and do not stack prints in the basket. Alternatively, turn
off the automatic cutter, see Turn the automatic cutter on and off on page 40, and use the Form feed
and cut key to release your print.

Paper menu procedure
As an alternative you can use the paper menu to start the paper loading process.

1. Follow steps one through five of the Easy loading procedure on page 26.

2.
From the front panel, select the Paper menu icon .
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3. Select Paper load.

4. Select Load roll.

5. Continue with step 9 of the easy loading process (see Select your paper category and type.
on page 28).

Unload a roll
Before unloading a roll, check whether there is paper on the roll or whether the end of the paper is no
longer attached to the roll, and follow the appropriate procedure as described below.

TIP: Do not touch the paper while the printer is printing, as it will cause image quality defects.

Unload paper key procedure with paper on the roll
If there is paper on the roll, use the following procedure.

1. Press the Unload paper key on the front panel.

2. When prompted by the front-panel display, lift the blue lever on the left.

3. When prompted by the front-panel display, lightly rewind the paper from the end of the spindle until
removed from the printer.

4. When prompted by the front-panel display, lower the blue lever.

Paper menu procedure with paper on the roll
If there is paper on the roll, you can also start the process from the front panel.

1.
Select the Paper menu icon .
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2. Select Unload paper.

3. Continue from step two of the Unload paper key process.

Roll out of paper procedure
If the end of the paper is no longer attached to the roll, use the following procedure.

1. If you have already started the unload process, press the Cancel key on the front panel to cancel
that procedure.

2. Lift the blue lever on the left. If the front panel displays a warning about the lever, ignore it.

3. Pull out the paper from the printer. Pull from wherever the paper is accessible; the back of the
printer is recommended.

4. Lower the blue lever.

5. If the front panel displays a warning message, press the OK key to clear it.

Load a single sheet
There are two ways to load a sheet. The easy loading procedure is recommended.

Any loaded roll or sheet must be unloaded before loading a sheet, see Unload a roll on page 29 or
Unload a single sheet on page 33.

NOTE: For sheets thicker than 0.5mm, you must have space behind the printer equal to the length of
the sheet.

Easy loading procedure
1. Standing in front of the printer, open the sheet tray.

TIP: If the tray is difficult to open, try opening from behind the printer.

30 Chapter 4   Paper handling ENWW

Paper handling



2. Insert the sheet into the feeder. Load your sheet aligned with the load line and insert until the paper
will not continue, with thicker sheets you feel resistance. The printer detects the sheet in three
seconds. A countdown begins on the front-panel display.

CAUTION: Do not push your fingers inside the printer's paper path.

3. After the countdown, the paper feeds into the printer. Guide the sheet into the printer; this is
especially important with thicker papers.

4. The front-panel display asks whether you are loading a roll, a sheet with skew check, or a sheet
without skew check. Select Sheet, with skew check or Sheet, without skew check with the Up
and Down keys.

NOTE: The recommended option is Sheet, with skew check.

NOTE: If you load without a skew check, print previews may not work properly. See Preview a
print on page 46.

5. Select your paper category and type.

TIP: If you have loaded a paper type whose name does not appear in the paper list, see The
paper type is not in the driver on page 113.
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6. If you selected Sheet in the Paper Load menu, the printer checks the alignment and measures
the sheet.

NOTE: Depending on the length of the sheet, it feeds out the front of the printer.

If you selected Sheet, without skew check, you will need to align the sheet manually.

7. If the paper has been loaded successfully, the front panel displays the Ready message and the
printer ready to print. If the paper is not straight, follow the instructions on the front-panel display.

NOTE: When correctly loaded, the sheet is in the back of the printer.

NOTE: If you have an unexpected problem at any stage of the paper loading process, see The paper
cannot be loaded successfully on page 112.

Paper menu procedure
As an alternative you can use the front panel to start the paper loading process

1. Perform step one of the easy loading procedure.

2.
Select the Paper menu icon .
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3. Select Paper load.

4. Select Sheet, with skew check or Sheet, without skew check.

NOTE: The recommended option is Sheet, with skew check.

NOTE: If you load without a skew check, print previews may not work properly. See Preview a
print on page 46.

5. Continue with step 5 of the easy loading procedure (see Select your paper category and type.
on page 31).

Unload a single sheet
To unload a sheet without printing, use the Unload paper key or the paper menu procedure.

NOTE: To unload a single sheet after printing, you can simply pull the sheet free from the front of the
printer.

TIP: Do not touch the paper while the printer is printing, as it will cause image quality defects.

Unload paper key procedure
1. Press the Unload paper key on the front panel.

2. The sheet unloads out the front of the printer, either catch it manually or allow it to fall into the
basket.
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Paper menu procedure
You can also unload a sheet from the Paper menu.

1.
Select the Paper menu icon .

2. Select Unload paper. The sheet unloads out of the front of the printer, either catch it manually or
allow it to fall into the basket.

View information about the paper
To view the loaded paper information, press the View loaded paper key on the front panel.

You can also select the Paper menu icon  and then View loaded paper.

The following information is displayed on the front panel:

● Roll or sheet status

● Paper type you have selected

● Width of the paper (estimated)

● Length of the sheet (estimated)

● Color calibration status

● Paper advance calibration status

NOTE: If you loaded a cut sheet with no skew check, the estimated length should be disregarded
because the printer cannot estimate it accurately.

If no paper is loaded, the message Out of paper is displayed.

The same information (apart from the color and paper advance calibration status) is displayed in the HP
Printer Utility, on the Supplies page.
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NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 124.

Paper presets
Each supported paper type has its own characteristics. For optimum print quality, the printer changes
the way it prints on each different paper type. For example, some may need more ink and some may
require a longer drying time. So the printer must be given a description of the requirements of each
paper type. This description is called the paper preset. The paper preset contains the ICC profile, which
describes the color characteristics of the paper; it also contains information on other characteristics and
requirements of the paper that are not directly related to color. Existing paper presets for your printer
are already installed in the printer's software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer contains
paper presets only for the most commonly used paper types. If you have a paper type for which your
printer has no preset, you cannot select that paper type in the front-panel display.

There are three ways to assign a preset for a new paper type.

● Import a paper preset that you have downloaded from the Web. See To install a downloaded paper
preset on page 35.

● Create your own paper preset using the HP Color Center. See To create your own paper preset
on page 36.

● Advanced users can create and adjust paper presets using the HP Color Center. See Advanced
paper preset creation on page 37.

NOTE: You can use a maximum of 30 custom and additional paper types. To delete a custom or
additional paper preset, go to the Color Center and select Paper Preset Management > Delete Paper
Preset. Paper presets provided with your printer cannot be deleted.

To install a downloaded paper preset
1. After finding the right paper preset at http://www.hp.com/go/z3200/paperpresets/ or at the paper

manufacturer's Web site, click the Download Now button and save the paper preset (“.oms” file)
on your computer.

NOTE: If you do not find the paper preset you want on the Web, you may find that it has been
added to the latest firmware for your printer. You can check the firmware release notes for
information, see Update the firmware on page 98.

2. Before starting to install the new preset, make sure that the printer is idle and the print queue is
stopped. Installing a new paper preset will interrupt any printing that is in progress.

3. Start the HP Printer Utility or the Embedded Web Server.

● In the HP Printer Utility, select the Color Center and then Import Paper Preset.

● In the Embedded Web Server, select the Setup tab, then Paper preset management, then
the Import tab.

4. On the Import page, select the paper preset file that you downloaded in step 1.

5. Click the Update button and wait for the update process to finish. It may take some time. The printer
will automatically restart when the update is complete; wait until it has restarted and the front panel
indicates that it is ready.
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6. Check that the new paper type appears in the Additional paper or Custom paper category in
your printer's front panel.

7. Synchronize the new paper type with the driver by opening the HP Printer Utility. Select your printer,
then the Color Center tab, then Paper Preset Management and Synchronize Paper Presets
(  button under Mac OS).

Now that you have imported the paper preset, you can select the paper type from the front panel and
from the driver. The ICC profile for the new paper type is ready to use by your application.

To create your own paper preset
Before using a custom paper type with your printer, you should add a paper preset for the new paper.
You can create a new paper preset using the HP Color Center in the HP Printer Utility.

The paper preset name will appear in the printer driver and the front panel.

To create a paper preset, you can follow this simple procedure:

1. Go to the Color Center tab in the HP Printer Utility for Windows, or to the HP Color Center group
in the HP Printer Utility for Mac OS.

2. Select Create New Paper Preset.

3. Enter your paper's name.

TIP: The paper's commercial name is likely to be the most understandable for other users of the
printer.

4. Select a paper category from the drop-down menu. The paper category determines the amount of
ink used and other basic printing parameters. For more information, see the online help  in
the Color Center, and http://www.hp.com/go/Z3200/paperpresets/. The available categories are:

● Bond and Coated Paper: Fiber-based, thin papers with a matte surface. These papers use
matte black ink, no gloss enhancer, relatively low ink limits and high carriage position.

● Photo Paper: Photo-base, relatively thick papers with a variety of finishing from matte to satin
to glossy. These papers use photo black ink and gloss enhancer, with the exception of Photo
Matte Papers, relatively high ink limits and low carriage position, with the exception of Baryte
and Photo Matte Papers. Generally they will print with the starwheels up.

● Proofing Paper: A variety of papers from matte to satin and glossy used to simulate
commercial printing with high color accuracy requirements.

● Fine Art Material: Canvas, matte and paper-base photo materials used for high-quality fine
art printing. These papers use matte black ink and no gloss enhancer, with the exception of
Canvas Satin and Pearl papers, which use photo black and gloss enhancer. They all use high
carriage position with high ink limits.

● Film: Synthetic film-base materials that generally use photo black and no gloss enhancer,
with relatively low ink limits and high carriage position.

● Backlit: Synthetic translucent materials that use photo black and no gloss enhancer with high
ink limits, high carriage position and starwheels up.

5. Click Next under Windows, Continue under Mac OS.

6. Load your custom paper, see Load a roll into the printer on page 25 or Load a single sheet
on page 30. You will find the paper name in the Custom paper category in the front panel.

7. Choose the ICC profile name in the Color Center. This is the name you will use to select the profile
in your application.
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8. Click Next under Windows, Continue under Mac OS.

9. If the paper type permits, the printer performs a color calibration (about 10 minutes) and creates
the ICC profile (about 20 minutes).

Now that you have created the paper preset, you will be able to select the paper type from the front
panel and from the driver under the Custom paper category. The ICC profile for the new paper type
will be ready to use by your application.

You can export the new paper preset to your computer and use it on other HP Designjet Z3200 series
printers. In the Color Center, select Paper Preset Management > Export Paper Preset, then follow
the instructions on the screen. To install the preset on another printer, see To install a downloaded paper
preset on page 35.

Advanced paper preset creation
Advanced paper preset creation involves a process of trial and error, in which you modify the printing
properties of your new preset to obtain the best print quality.

1. Go to the Color Center tab in the HP Printer Utility for Windows, or to the HP Color Center group
in the HP Printer Utility for Mac OS.

2. Select Paper Preset Management.

3. Under Windows, select Create Paper Preset. Under Mac OS, click +.

4. Enter your paper's name.

TIP: The paper's commercial name is likely to be the most understandable for other users of the
printer.

5. Select a paper category from the drop-down menu. The paper category determines the amount of
ink used and other basic printing parameters. For more information, see the online help  in
the Color Center, and http://www.hp.com/go/Z3200/paperpresets/. The available categories are:

● Bond and Coated Paper: Fiber-based, thin papers with a matte surface. These papers use
matte black ink, no gloss enhancer, relatively low ink limits and high carriage position.

● Photo Paper: Photo-base, relatively thick papers with a variety of finishing from matte to satin
to glossy. These papers use photo black ink and gloss enhancer, with the exception of Photo
Matte Papers, relatively high ink limits and low carriage position, with the exception of Baryte
and Photo Matte Papers. Generally they will print with the starwheels up.

● Proofing Paper: A variety of papers from matte to satin and glossy used to simulate
commercial printing with high color accuracy requirements.

● Fine Art Material: Canvas, matte and paper-base photo materials used for high-quality fine
art printing. These papers use matte black ink and no gloss enhancer, with the exception of
Canvas Satin and Pearl papers, which use photo black and gloss enhancer. They all use high
carriage position with high ink limits.

● Film: Synthetic film-base materials that generally use photo black and no gloss enhancer,
with relatively low ink limits and high carriage position.

● Backlit: Synthetic translucent materials that use photo black and no gloss enhancer with high
ink limits, high carriage position and starwheels up.
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6. If you wish, use the Change Printing Properties button to change the following properties:

● Paper Thickness: This is relevant to carriage height or platen gap. You should choose
High if your paper weighs over 250 g/m² or if it does not have a plastic coating.

● Dry Time: The recommendation is to use Automatic by default and move to Extended if
needed.

● Starwheels: Print with the starwheels up or down.

● Cutter: Enable or disable the cutter.

● Global Ink Limit: Initially it can be left as it is and modified later on, based on printing results.

● Gloss Enhancer Amount: Initially it can be left as it is and modified later on, based on printing
results.

NOTE: When an option is grayed out, that means that it is not available for the selected paper
type.

Some paper types are available with different ink limits (less/normal/more ink). Ink limits are
generally proportional to color gamut volume, but a higher ink limit can cause printing artifacts
(bleed, coalescence, etc.) in some cases. HP papers have fine-tuned ink limits while other papers
use generic ink limits.

7. Click Next under Windows, Continue under Mac OS.

8. Load your custom paper, see Load a roll into the printer on page 25 or Load a single sheet
on page 30. You will find the paper name in the Custom paper category in the front panel.

9. Under Windows, select yes when asked to calibrate paper. Under Mac OS, select Paper Preset
Management > Calibrate Paper. For more information on color calibration, see Color
calibration on page 60.

10. You can print an image of your choice to check for color gamut, coalescence, mottle, bronzing and
gloss uniformity. If the results are not satisfactory, you can change printing properties and launch
another calibration. For instance:

● For better color gamut, increase the ink limit or select a "more ink" variant of the same paper
type if available.

● To reduce coalescence, decrease the ink limit and/or the amount of gloss enhancer or select
a "less ink" variant of the same paper if available.

● To reduce bronzing or improve gloss uniformity, adjust the amount of gloss enhancer.

For more information, see the online help  in the Color Center.

11. With your final printing properties, you can now create an ICC profile for the paper using one of the
following three options:

● The standard process with the Color Center (see Color profiling on page 61).

● The HP Advanced Profiling Solution (supplied with your printer). For more information on the
HP Advanced Profiling Solution, see its own documentation and also http://www.hp.com/go/
z3200/solutions/.

● A third-party profiling program (see Color measurement on page 63).

12. Once you have created and adjusted the ICC profile for your paper, you can link this profile to the
paper preset with the Color Center: select Paper Preset Management > Install Profile. If you
have used the standard Color Center profiling process, this step is not necessary because the
profile is linked automatically to the paper preset.
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For more information on the processes available in the Color Center, see A summary of the color
management process on page 59.

Now that you have created the paper preset, you will be able to select the paper type from the front
panel and from the driver under the Custom paper category. The ICC profile for the new paper type
will be ready to use by your application.

You can export the new paper preset to your computer and use it on other HP Designjet Z3200 series
printers. In the Color Center, select Paper Preset Management > Export Paper Preset, then follow
the instructions on the screen. To install the preset on another printer, see To install a downloaded paper
preset on page 35.

Print on loaded paper
To print a job on whichever paper is loaded in the printer, select Any in the Paper Type option of your
printer driver.

● In the Windows driver dialog: select the Paper/Quality tab, then select Any in the Paper Type
drop-down list.

● In the Mac OS Print dialog: select the Paper Type/Quality panel, then select Any in the Paper
Type drop-down list.

NOTE: Any is the default Paper Type selection.

Move the paper
If the printer is idle (ready to print), you can move the paper forwards or backwards from the front panel.
You may want to do this in order to have more or less white space between the last print and the next
one.

To move the paper, select the Paper menu icon  and then Move paper.

You can move the paper forwards by pressing the Up key on the front panel, or backwards by pressing
the Down key. When the paper is positioned as you want it, press the OK key.

Maintain the paper
To maintain paper quality, follow the recommendations below.

● Store rolls covered by another piece of paper or cloth.

● Store cut sheets covered and clean or brush them before loading them in the printer.

● Clean input and output platens and cut sheet tray.

● Always keep the transparent window of your printer closed.

NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 124.
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Change the drying time
You may wish to change the drying time setting to suit special printing conditions such as multiple prints
where time is of higher importance or when you need to be sure ink is dry before handling.

NOTE: Most paper types require no drying time.

Select the Setup menu icon , then Print retrieval> Select drying time. You can select:

● Extended, to set a longer than recommended time to ensure ink is completely dry

● Optimal, to set the default and recommended time for your selected paper

● Reduced, to set a shorter than recommended time when quality is of lower importance

● None, to disable the drying time and remove your print as soon as it finishes printing

TIP: If the ink is not dry when the print is removed it could leave ink in the output tray and marks on
the print.

NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right
away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts
the paper and then performs the printhead maintenance. However, if the dry time is greater than zero,
the printer does not cut the paper until after the printhead maintenance has completed, even if the Form
feed and cut key has been pressed.

Turn the automatic cutter on and off
To turn the printer's paper cutter on or off:

● From the HP Printer Utility for Windows, select the Settings tab and change the Cutter option
in Printer Settings > Advanced.

● From the HP Printer Utility for Mac OS, in the Configuration group, select Printer Settings >
Configure Printer Settings and change the Cutter option in Printer Settings > Advanced.

● From the Embedded Web Server, select the Setup tab, then Printer Settings, and change the
Cutter option in Printer Settings > Advanced.

●
From the front panel, select the Setup menu icon , and then Print retrieval > Enable cutter.

NOTE: To cut rolled paper while the automatic cutter is disabled, see Feed and cut the paper
on page 40.

Feed and cut the paper
To feed and cut the paper when the automatic cutter has been disabled, or when the front edge of the
paper is not straight, press the Form feed and cut key on the front panel. The paper advances and a
message is displayed on the front panel:

Select the cutting position by pressing the arrow keys backward and forward

If you immediately press the OK key, the printer will make a straight cut removing a 4-inch strip from the
front edge of the paper.

Alternatively, you can use the Up and Down keys to remove more or less of the paper (minimum 2
inches). Open the window to see where the cut will be made, indicated by a scissors label at the side
of the carriage. The window can remain open while you are moving the paper. When you have finished
moving the paper, close the window and press the OK key.
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NOTE: The printer may not cut the paper immediately, as the printheads are serviced after each print
and the paper cannot be cut until that process is complete.

When the paper has been cut, remove the cut piece from the output tray.

TIP: If strips or short prints are left in the output tray the printer could jam.

TIP: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 124.
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5 Printing

● Select print quality

● Select paper size

● Select margins options

● Print with shortcuts

● Rescale a print

● Preview a print

● Print a draft

● High-quality printing

● Print in gray shades

● Print with no margins

● Reprint an old job

● Rotate an image

● Print with crop lines

● Print on sheet paper

● Use paper economically

● Use ink economically
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Select print quality
The printer has various print-quality options because best-quality printing requires some loss of speed,
while fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and
speed.

Alternatively, you can select from the custom options: Best, Normal and Fast. There are also three
supplementary custom options that may have an effect on print quality: Maximum detail, More
passes and Gloss enhancer. See High-quality printing on page 47.

NOTE: In the Windows driver dialog, the rendering and printing resolutions for your job are displayed
in the Paper/Quality tab. In the Mac OS Print dialog, they are displayed in the Summary panel.

You can select print-quality options in the following ways:

● In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
If you select Standard Options, you will see a simple slider with which you can select speed or
quality. If you select Custom Options, you will see the more specific options described above.

● In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Paper. If you
select Standard quality options, you will see a simple slider with which you can select speed or
quality. If you select Custom quality options, you will see the more specific options described
above.

NOTE: You cannot change the print quality of pages that the printer is already receiving or has already
received (even if they have not started to print yet).

Select paper size
The paper size can be specified in the following ways.

NOTE: The paper size specified here should be the paper size in which the document was created.
It is possible to rescale the document to a different size for printing. See Rescale a print on page 45.

● In the Windows driver dialog: select the Paper/Quality tab, then select your paper size from the
Document Size list.

● In the Mac OS Page Setup dialog: select your printer in the Format for popup menu, then Paper
Size.

TIP: If your document is 13 × 19 in (33 × 48.3 cm), designed to fit on sheet paper of the same size,
select the document size Super B/A3.

Custom paper sizes
To choose a non-standard paper size not shown in the list of paper sizes:

● Under Windows, there are two different ways:

◦ In the driver dialog, press the Custom button in the Paper/Quality tab, then specify the name
and the dimensions of your new paper size, then click Save to save your new paper size.

NOTE: The driver will not allow you to create a paper size whose width exceeds its length.

◦ From the Start menu, select Printers and Faxes, then from the File menu select Server
Properties. In the Forms tab, check the Create a new form box, specify the name and
dimensions of the new form, then click Save Form.

● In the Mac OS Page Setup dialog, select Paper Size > Manage Custom Sizes.
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Select margins options
By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the
paper (17 mm at the foot of a sheet of paper). However, you can change this behavior in several ways.

● In the Windows driver dialog: select the Paper/Quality tab and then the Margins/Layout button.

● In the Mac OS Print dialog: select the Paper Type/Quality panel and then Layout.

You will then see at least some of the following options.

NOTE: Under Mac OS, the available margins options depend on the paper size selected in the Page
Setup dialog. For instance, for borderless printing you must select a paper size name that includes the
words “no margins”.

● Standard. Your image will be printed on a page of the size you have selected, with a narrow margin
between the edges of the image and the edges of the paper. The image should be small enough
to fit between the margins.

● Oversize. Your image will be printed on a page slightly larger than the size you have selected. If
you cut off the margins, you will be left with a page of the size you selected, with no margins
remaining between your image and the edges of the paper.

● Clip Contents By Margins. Use this option when your image has white borders and a size equal
to that of the paper you have selected. The printer will use the white border for its margins and you
will get a page of size equal to that which is selected in the driver.

● Borderless. Your image will be printed on a page of the size you have selected, with no margins.
The image is slightly enlarged to ensure that no margin is left between the edges of the image and
the edges of the paper. If you select Automatically by Printer, this enlargement is done
automatically. If you select Manually in Application, you should ensure that the image size in your
application is slightly larger than the paper size. See also Print with no margins on page 49.

Print with shortcuts
The printer driver provides many options that can be set to different values when printing a particular
job. A printing shortcut stores the values of all these options that are appropriate for a particular kind of
job, so that you can set them all with a single click. Some settings (such as paper size, paper source
and orientation) may be overridden by the values provided by your application.

To use a shortcut, select the Printing Shortcuts tab in the Windows driver dialog.

NOTE: Shortcuts are available only under Windows.
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You can see a list of available shortcuts; select the one that matches the kind of job you want to print.

The driver options are now adjusted to suit your job. You can either print immediately, or examine the
settings to check that you agree with them. If you like, you can select a shortcut and then change some
of its settings manually.

TIP: Check at least the settings that you can see in the Printing Shortcuts tab: the document size,
orientation, etc.

The Factory Defaults shortcut contains the printer's default settings. When you click it, it sets all options
to their default values.

Printing shortcuts can be customized to your particular needs. To create your own shortcut:

1. Select the shortcut that comes closest to satisfying your requirements.

2. Change any value in the Printing Shortcuts tab and/or other tabs.

3. Save the new printing shortcut.

If you decide later that you no longer want a shortcut, you can delete it.

Rescale a print
You can send an image to the printer at a certain size but tell the printer to rescale it to a different size
(normally larger). This may be useful if your software does not support large prints.

You can rescale an image in the following ways:

● In the Windows driver dialog: go to the Features tab and look at the Resizing Options section.

◦ The Print document on option adjusts the image size to the paper size you have selected.
For example, if you have selected ISO A2 as the paper size and you print an A4-size image,
it is enlarged to fit the A2 paper. If the ISO A3 paper size is selected, the printer reduces a
larger image to fit the A3 size.

◦ The % of actual size option enlarges the printable area of the original paper size (the page
minus the margins) by the percentage indicated, then adds the margins to create the output
paper size.

● In the Mac OS Print dialog: select the Paper Handling panel, then Scale to fit paper size, and
select the paper size to which you want to scale the image. If you want to increase the size of the
image, make sure that the Scale down only box is unchecked.
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If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet,
otherwise the image will be clipped.

Preview a print
Previewing a print on the screen allows you to check the layout of the print before printing, which may
help you to avoid wasting paper and ink on a bad print.

NOTE: If you load sheet paper without a skew check, the printer does not measure the length of the
sheet, so the print preview will not be a reliable guide to the final printout.

● To preview a print under Windows, you have two options:

◦ Use your application's print preview option.

◦ Check the Show preview before printing option, which you can find in the driver's Printing
Shortcuts tab, Paper/Quality tab and Features tab. The preview is shown before printing;
you can check the print settings and the layout of the image, and then click Print to proceed
with printing or Cancel to cancel the job.

● To preview a print under Mac OS, you have three options:

◦ Use your application's print preview option.

◦ Click the Preview button at the bottom of the Print dialog box. This is the basic print preview
provided by Mac OS.
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◦ Click the PDF button at the bottom of the Print dialog box, then click HP Print Preview. This
provides a preview with more features, such as the ability to change paper size, paper type
and print quality, and to rotate the image. See below:

NOTE: HP Print Preview is not available if you are using Adobe InDesign, Adobe Illustrator,
Adobe Reader or Apple Aperture.

Print a draft
You can specify fast draft-quality printing in the following ways:

● In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
Move the print-quality slider to the extreme left ('Speed').

● In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Paper, then move
the print-quality slider to the extreme left ('Speed').

High-quality printing
You can specify high-quality printing in the following ways:

● In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
Move the print-quality slider to the extreme right ('Quality').

● In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Paper, then move
the print-quality slider to the extreme right ('Quality').
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If you have a high-resolution image
If your image has a resolution greater than the rendering resolution (which you can see in the driver's
Paper/Quality tab under Windows), print sharpness may be improved by selecting the Maximum
Detail option.

● In the driver dialog (Mac OS Print dialog): select custom instead of standard print-quality options,
then check the Maximum Detail box.

NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not
increase the amount of ink used.

If you have printhead problems
If your printheads have an excessive number of clogged nozzles (which may cause banding or white
streaks on your prints), print quality can be improved by selecting the More Passes option.

● In the driver dialog (Mac OS Print dialog): select custom instead of standard print-quality options,
then check the More Passes box.

NOTE: The More Passes option results in slower printing, but it does not increase the amount of ink
used.

TIP: Instead of using this option, consider using the Image Diagnostics Print to identify the printhead
or printheads that are causing the problem, and then clean or replace them. See The Image Diagnostics
Print on page 133.

If you are printing on photo paper
If you are printing on photo paper, you have the option of using the gloss enhancer, which improves
overall gloss quality and reduces or eliminates bronzing. There are three settings:

● Off: the gloss enhancer is not used.

● Economode: the gloss enhancer is used in inked areas of the image, but not in ink-free (white)
areas.

● Whole page: the gloss enhancer is used over the whole area of the defined page, including ink-
free areas.

If the print quality slider is set to Quality, the Gloss enhancer option is automatically set to Whole
page. To change this setting:

● In the driver dialog (Mac OS Print dialog): select custom instead of standard print-quality options,
then the Gloss enhancer option.

When Gloss enhancer is set to Whole page, you can further reduce bronzing, if necessary, by
increasing the amount of gloss enhancer used. This can be done from the HP Printer Utility: select
Color Center > Paper preset management > Change printing properties. The Gloss enhancer
amount can be adjusted to use more or less gloss enhancer. Using more gloss enhancer will reduce
bronzing and make the gloss more even across the page; however, it may cause blurriness or
graininess.

If you are printing on satin photo paper
If you are printing on satin photo paper, consider using HP Professional Satin Photo Paper, which can
offer:

● A wider color gamut

● Better black optical density
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● Better PANTONE coverage

● A smoother surface

● Greater robustness

Print in gray shades
You can convert all colors in your image to shades of gray in the following ways:

● In your application program: many programs provide this option.

● In the Windows driver dialog: go to the Color tab and look at the Color Options section.
Select Print in Grayscale.

● In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Color, then select
Print In Grayscale.

See also Print a black-and-white photo for an exhibition (Photoshop, Mac OS) on page 70.

Print with no margins
Printing with no margins (to the edges of the paper) is known as borderless printing. This can be done
only on rolls of glossy or satin paper.

In order to be sure of leaving no margins, the printer prints slightly past the edges of the paper. Any ink
deposited outside the paper is absorbed by the sponge situated in the platen.

NOTE: If you wish to print with no margins, you must ensure that your image will fill the page. If your
image is smaller than the page, it will not be automatically stretched.

You can request printing with no margins in the following ways:

● In the Windows driver dialog: select the Paper/Quality tab and press the Margins/Layout
button. Then select Borderless.

● In the Mac OS Page Setup dialog: select a paper size name that includes the words “no margins”.
Then, in the Print dialog, select Paper Type/Quality > Layout > Borderless.

When you select Borderless, you must also select one of the following Image Enlargement options:

● Automatically by Printer means that the printer automatically enlarges your image slightly
(normally by a few millimeters in each direction) in order to print over the edges of the paper.

● Manually in Application means that you must enlarge the image yourself in your application to a
size slightly larger than the actual paper size.

NOTE: If the first print job after loading paper is a borderless job, the printer may trim the leading edge
of the paper before printing.

At the end of a borderless print, the printer normally cuts the print slightly inside the image area to ensure
that the print is borderless. It then cuts the paper again so that no residual part of the image is included
in the next print. However, if the job is cancelled, or if there is white space at the bottom of the image,
only a single cut is made.

Reprint an old job

You can reprint the last job from the front panel: select the Job Management menu icon , then
Reprint last job.
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In addition, you may be able to use your operating system's printer spooler to reprint old jobs, if you
have already told the spooler to save old jobs. This facility depends on your operating system.

Rotate an image
By default, images are printed with their shorter sides parallel to the leading edge of the paper, like this:

You may wish to rotate your images by 90 degrees in order to save paper, like this:

You can do this in the following ways:

● In the Windows driver dialog: select the Features tab, then Rotate by 90 degrees.

● In the Mac OS Print dialog: select the HP Print Preview and then Rotate by 90 degrees.

●
In the front panel: select the Setup menu icon , then Printing preferences > Paper >
Rotate.

NOTE: If rotation is set from your computer, it overrides the setting in the front panel.

NOTE: When you rotate a job, the page length may be increased to avoid clipping, because the top
and bottom margins are usually larger than the side margins.

NOTE: With either rolls or sheets, if you rotate an image to landscape whose original orientation was
portrait, the paper may not be wide enough for the image. For example, rotating a portrait D/A1-size
image on D/A1-size paper by 90 degrees will probably exceed the width of the paper. If you are using
the Embedded Web Server, the preview screen will confirm this with a warning triangle.
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Autorotate
With some printer drivers, you can also select the Autorotate option, which will automatically rotate by
90 degrees any oversized portrait images in order to save paper.

Print with crop lines
Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print
crop lines automatically with individual jobs in the following ways:

● In the Windows driver dialog: select the Features tab, then Enable crop lines.

● In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Paper, then select
Enable crop lines.

●
Using the front panel: select the Setup menu icon , then Printing preferences > Paper >
Enable crop lines > On.

Print on sheet paper
To print on cut-sheet paper, first load the sheet of paper (see Load a single sheet on page 30). Then:

● Under Mac OS: select a paper size described as “for sheet paper”, then select Manual Feed as
the Paper Source.

● Under Windows: select Manual Feed as the Paper Source.

Use paper economically
Here are some recommendations for making economical use of paper:

● If you are printing relatively small images, you can print up to 16 of them on one sheet of paper.
Use the Pages per sheet option in the Features tab (Windows driver) or the Layout panel (Mac
OS driver).

NOTE: This works for multipage documents only.

● You may be able to save some roll paper by using the following options:

◦ In the Windows driver dialog: select the Features tab and then Remove Top/Bottom Blank
Areas and/or Rotate by 90 degrees or Autorotate.

◦ In the Mac OS Print dialog: select the Paper Type/Quality panel, then Paper, then Remove
Top/Bottom Blank Areas; and/or select HP Print Preview, then Rotate by 90 degrees.

● If you check the print preview on your computer before printing, you can sometimes avoid wasting
paper on prints containing obvious mistakes. See Preview a print on page 46.
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Use ink economically
Here are some recommendations for making economical use of ink.

● Clean the printheads only when needed, and clean only those printheads that need cleaning.
Cleaning the printheads can be useful, but it uses ink.

● Leave the printer permanently turned on so that it can maintain the printheads in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not
done, the printer may need to use much more ink later to restore the health of the printheads.

● Wide prints make more efficient use of ink than narrow prints, because printhead maintenance
uses some ink, and its frequency is related to the number of passes made by the printheads.
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6 Color management

● What is color?

● The problem: color in the computer world

● The solution: color management

● Color and your printer

● A summary of the color management process

● Color calibration

● Color profiling

● Color management options

● Color adjustment options

● Color management scenarios
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What is color?
We see the world around us as steeped in color, where color is in the first instance simply an aspect of
how we experience our environment. Color is therefore subjective. Upon further inspection we find that
our color experiences are closely related to brain activity that is triggered by signals sent to it by our
eyes. These signals undergo a complex and highly interlinked sequence of processing stages that make
the relationship between what our eyes emit and what we experience anything but direct. The signals
sent by the eye depend on the light-sensitive cells that line the back of our eyes, and they belong to
three types, each sensitive to electromagnetic radiation of different physical properties (wavelengths).
Such electromagnetic radiation is called light and objects appear to have certain colors because of how
they interact with light (by emission, reflection, absorption, transmission, scattering, etc.).

Our individual experiences of color are also affected by our previous experiences and memories and
by the way in which we put our experiences into language. Finally, environmental factors such as
changes in lighting, scene content or the proximity of other colors also have an effect, which makes the
way in which we view a given display or print an essential part of the colors we will see. Differences in
all these aspects (from physiological differences between people, to differences in their past
experiences, memories and linguistic tendencies) can result in people talking about colors differently
even in response to the same light reflected from an single object. Nonetheless there are also many
similarities between how individuals experience color and it is possible to make very specific judgments
about it that others will also agree with when care is taken in the process. In conclusion we can say that
color results from the interaction between light, objects and a viewer, which makes it a very complex
and to a large degree subjective phenomenon.

The problem: color in the computer world
Color imaging devices such as printers, displays, projectors and televisions create colors by different
means and by using different materials (colorants). Displays, for instance, use colorants that emit red
(long wavelength), green (medium wavelength) and blue (short wavelength) light, where outputting a
white color requires the full use of all three colorants and black requires that none of them be used (i.e.
that no light be emitted). Devices that use light emitting colorants are called additive, because the light
from them is added together before it enters a viewer’s eyes. Printers, on the other hand, use materials
that absorb parts of the light that shines on them and because of this absorption, they are called
subtractive. Typical prints use cyan (red absorbing), magenta (green absorbing) and yellow (blue
absorbing) inks as well as an additional black ink that absorbs light at all wavelengths. To get white
using a printer requires not absorbing any of the light that illuminates a piece of paper and to get black,
all of the inks need to be used to absorb all of the light that is present.
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To control the output of color imaging devices, the following color spaces are normally used:

● RGB (Red, Green and Blue) is the color space typically used for additive devices. A color is
represented as a combination of specific quantities of red, green and blue colorants and all such
combinations address the range of colors (color gamut) of the chosen device.

NOTE: Subtractive devices can also be controlled using RGB data and, especially when you do
not require control over how you want to use your printer’s black ink, this is an efficient option.

● CMYK (Cyan, Magenta, Yellow and Black) is the color space for subtractive devices, such as
printers or presses. A color is represented as a combination of cyan, magenta, yellow and black
(K) inks and all such combinations let you address the entire range of colors of the chosen device.

Both of these color spaces are only ways of controlling different color imaging devices and their values
do not describe colors directly. The same CMYK values, for example, will give different colors when
sent to different printers that use different inks and paper types. For example, consider a printer that
can use indoor inks or outdoor inks. The printer (hardware) is the same, but it has two different color
gamuts due to the different chemistry of the inks (dye-based versus pigmented). Furthermore, they need
to work with different paper types, as ink interaction with the paper depends on its chemistry. Thus, the
colors resulting from given CMYK values depend on the types of inks and papers that you use with a
printer. If this is the case using the same printer, you can easily imagine how different results can be
obtained with printers using different technologies and therefore using different ink chemistry.

The same happens with RGB-controlled devices. For example, imagine that two different monitors from
the same manufacturer have their white points at 9600 K and 6500 K respectively. Their colors are going
to be different because they will be related to a different white point reference. The situation is even
worse when comparing monitors from different manufacturers. As a recommendation, set the white point
of your monitor to 5000 K (also called D50), since this is the standard color temperature for the graphic
arts industries. If you dislike the appearance of D50 (you may find it too yellowish), the second choice
is to set the display to 6500 K (D65).

NOTE: The white point is the brightest neutral color that a device can reproduce or that is present in
an image. The human visual system automatically adapts to the content of an image with respect to its
white point.

Furthermore, an RGB image, such as an image obtained from a digital camera and edited on a monitor,
needs to be first converted to CMYK for a specific printer before printing. Unfortunately different devices
do not give access to the same color gamuts: there are some colors that can be shown on a display
that cannot be matched in print and vice versa. The following graphic illustrates how colors visible to
the human eye are greater than those reproduced by a typical display or printer using a specific paper
type and also how the color gamuts accessible using these two color imaging devices do not match
each other.
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1. All colors

2. Computer monitor gamut

3. CMYK press gamut

Finally, there are some color spaces that are not device-dependent, but instead represent how a viewer
sees colors, such as CIE Lab or CIECAM02 defined by the CIE (Commission Internationale de
l’Éclairage). The advantage of these spaces is that, unlike CMYK or RGB, if two objects have the same
CIE Lab values then they will look the same when viewed under the same conditions. Values in these
spaces can be obtained from measuring the light emitted or reflected by an object.

The solution: color management
There are many colors from an RGB-controlled device that can no be reproduced in a CMYK-controlled
device and vice versa. These colors are called “out-of-gamut” colors. The industry uses two steps to
reduce color differences as much as possible:

● Describe the color behavior of each device as accurately as possible

● Convert one color gamut to another as effectively as possible

The solution:

1. Describe the color behavior of a device as accurately as possible using an ICC profile. By
taking various RGB or CMYK combinations, sending them to a device, measuring the resulting
output and expressing it in a device-independent color space (e.g. CIE Lab), the color behavior of
a device can be described. The resulting relationship is stored in an ICC profile, which is a standard
file that acts as a dictionary to translate the device’s color space (CMYK or RGB) to a device-
independent color space (e.g. CIE Lab). The process of generating an ICC profile is called profiling.

2. Convert colors as effectively as possible using a Color Management System (CMS). A CMS
is software that uses information from ICC profiles to transform one device’s color space (defined
by a source profile) into the color space of another device (defined by a destination profile). The
difficult part of the job is with those colors that exist in one device’s gamut but not in the other. We
will explore this in more detail later on.

Briefly, we can describe any CMS by the following 4 settings:
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● CMS: CMS stands for Color Management System. It is the application that converts the color
information stored in the input image, which has the color space defined by a source profile, into
an output image that has the color space specified by a destination profile. There are many different
CMSs on the market: there are CMSs in applications, in operating systems and in printing software
provided by printer manufacturers (in our case the HP Designjet Z3200 internal RIP).

● Source profile: a description of the color behavior of the input device.

● Destination profile: a description of the color behavior of the output device.

● Rendering intent: the most difficult challenge in color management is when a color in the source
gamut does not correspond directly to a color in the destination gamut. As a perfect match is not
possible, there are different types of choices that can be made about how to treat gamut differences
and these are called rendering intent. There are four different possibilities depending on the final
output you want to achieve.

◦ Use Perceptual for the most pleasing final output from your original RGB image. It is suitable
for photographic content.

◦ Use Saturation for vivid final output. It is suitable for business graphics (charts, presentations,
etc.), but is not recommended for color matching.

◦ Use Relative Colorimetric for press proofing. This rendering intent provides a match for
colors that are inside both the source and destination gamuts and minimizes differences when
a match is not possible.

◦ Use Absolute Colorimetric for press proofing (like Relative Colorimetric), when you also
want to simulate the color of the source’s paper.

TIP: You can use "soft proofing" options in your application (such as Photoshop and InDesign) to view
the result of each rendering intent.

The most commonly used device color spaces and, therefore, profiles are:

● RGB mode:

◦ sRGB (sRGB IEC61966-2.1): for images originating typically from consumer digital cameras
and scanners and in general from the Web

◦ Adobe RGB (1998): for images originating typically from professional digital cameras

◦ Specific RGB device space: for images coming from or going to a specific RGB device that
has been profiled. The HP Designjet Z3200 has the capability to measure itself and generate
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an RGB ICC profile, describing its color behavior for the paper that was loaded at the time of
measuring.

● CMYK mode:

◦ SWOP: abbreviation of “Specifications for Web Offset Publications”, a set of press standards
defined for a typical US press and for different types of paper

◦ ISO 12647-2: a set of press standards defined by the International Standards Organization
for different types of paper (Coated, Uncoated, …)

◦ Other regional standards: Euroscale, JMPA, Japan Color

◦ Specific CMYK device space: for images coming from or going to a specific CMYK device
that has been profiled

Color and your printer
As a creative professional, predictable and dependable results from your printer are essential to getting
your job done. Predictability is a key element of an efficient color workflow. You need prints that match
your expectations with neutral grays and correct colors on your selected paper. Your prints should be
produced consistently print-to-print and printer-to-printer. Dependability ensures that every print is free
of print-quality defects and ready to use or send to your customer. You save time and effort and avoid
wasting ink and paper, and you can meet demanding production schedules by printing overnight with
confidence.

HP Designjet Z3200 printers have been engineered with advanced hardware and driver features to
ensure predictable and dependable results, and offer dramatic improvements in efficiency and control
for your color workflow.

HP Embedded Spectrophotometer
HP Designjet Z3200 printers revolutionize professional color workflows by using a built-in
spectrophotometer for color calibration and profiling.

A spectrophotometer is a precision instrument that can determine the exact composition of light reflected
from a color patch. It splits the reflected light into different wavelength components, just as Newton’s
prism splits white light into the colors of the rainbow, and measures the strength of each component.
The HP Embedded Spectrophotometer is mounted on the printhead carriage.

The spectrophotometer allows HP Designjet Z3200 printers to generate custom ICC profiles
automatically for your preferred paper types and calibrate the printers to deliver print-to-print and printer-
to-printer repeatability with less than half the color error of earlier HP Designjets, under all environmental
conditions, and even on unknown (not factory-profiled) paper types. A built-in white calibration tile,
protected by an automatic shutter, ensures reliable measurements that meet international standards.

The printer, color imaging pipeline and professional-quality spectrophotometer with GretagMacbeth i1
color technology are integrated with the HP Color Center software for the HP Designjet Z3200. Giving
the calibration and profiling processes direct access to the writing system allows precise control of ink
levels and color separations for each printed color patch. The automated measurement process
eliminates handling the test print, provides repeatable drying times and allows fast measurements with
precise electromechanical positioning of the spectrophotometer over the color patch. This provides
unprecedented ease of use and matches or exceeds the performance of more expensive off-line,
handheld profiling systems.
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A summary of the color management process
To get the accurate and consistent colors that you want, you should follow these steps for each paper
type that you use.

1. If your paper type is not already known to the printer, add it to the printer's list of known papers.
See To create your own paper preset on page 36. Typical users may add a few custom paper types
every year.

2. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and
then, when recommended by a printer alert (typically, every few weeks for each paper type you
use). In addition, you may wish to calibrate immediately before a particularly important print job for
which color consistency is vital.

3. Color-profile the paper type, for accurate colors. Profiling does not normally need to be repeated:
once you have a profile for a particular paper type, you can continue to use it. However, re-profiling
does no harm, and some users repeat the profiling process every month to ensure that the profile
is up to date.

4. When printing, select the correct color profile for the paper type you are using.

If you use a paper type already defined in the printer, it has a color profile already, but you should at
least calibrate it before using it.

If you define a new paper type, you are automatically led through the steps of calibration and profiling.

The following diagram shows the operations handled by the HP Color Center, in the correct order.

NOTE: You can perform all three operations in sequence as shown, but you can also choose to start
with or stop after any of the three operations. With one exception: color calibration is performed
automatically after adding a new paper type.
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Color calibration
Color calibration enables your printer to produce consistent colors with the particular printheads, inks
and paper type that you are using, and under your particular environmental conditions. After color
calibration, you can expect to get identical prints from any two different printers situated in different
geographical locations.

Calibration should be done in any of the following circumstances:

● Whenever a printhead is replaced

● Whenever a new paper type is introduced that has not yet been calibrated with the current set of
printheads

● Whenever a certain amount of printing has been done since the last calibration

● Whenever the printer has been turned off for a long period of time

● Whenever the environmental conditions (temperature and humidity) change significantly

The printer driver usually reminds you with an alert whenever you need to perform color calibration,
unless you have disabled the alerts. However, there will be no alert if the environmental conditions
change.

You should calibrate a paper type before creating its color profile; however, you can later recalibrate
without needing to recreate the color profile.

You can turn off color calibration from the front panel: select the Image Quality Maintenance menu icon

, then set Enable color calibration to OFF. In this case, the printer will use a default calibration
set in the factory for all paper types. If you later turn color calibration back on, it will still remember any
calibrations that you performed earlier.

Check calibration status
You can check the color calibration status of the currently loaded paper at any time by pressing the
View loaded paper key on the front panel. The status may be one of the following:

● PENDING: the paper has not been calibrated.

NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is
reset to PENDING. See Update the firmware on page 98.

● OBSOLETE: the paper has been calibrated, but the calibration is now out of date for one of the
reasons mentioned above, and should be repeated.

● OK: the paper has been calibrated, and the calibration is up to date.

● N/A: this paper cannot be calibrated. The following paper types cannot be calibrated: plain paper,
transparent materials, and textured glossy paper (such as HP Collector Satin Canvas). They can,
however, be profiled.

Calibrate
You can start color calibration in the following ways:

● From the printer driver alert that recommends calibration.

● From the HP Color Center: select Paper Preset Management > Calibrate Paper.

●
From the front panel: select the Image Quality Maintenance menu icon , then Calibrate
color.
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The calibration process is fully automatic and can be performed unattended after you have loaded paper
of the type you wish to calibrate—which should be A4, Letter or any larger size.

The process takes about 8–10 minutes and consists of the following steps.

1. A calibration test chart is printed, which contains patches of each ink used in your printer.

2. The chart is allowed to dry for a period of time that depends on the paper type, so that the colors
have time to stabilize.

3. The chart is scanned and measured using the HP Embedded Spectrophotometer.

4. From the measurements made by the spectrophotometer, the printer calculates the necessary
correction factors to apply for consistent color printing on that paper type. It also calculates the
maximum amount of each ink that can be applied to the paper.

TIP: If color calibration fails, check whether a color is missing from the chart. A missing color may be
caused by a printhead problem: see Troubleshooting ink cartridge and printhead issues on page 137.

NOTE: Matte black is not used on glossy or satin papers, so that column of the chart is not printed
when calibrating those paper types.

Calibration from Photoshop
When you use Adobe Photoshop CS3 (or later version) for Windows, the Print window can warn you if
the paper needs color calibration, and can provide an icon  to launch the HP Printer Utility to perform
the calibration.

To enable this capability under Windows XP, you must download and install the following free software
packages from Microsoft's Web site:

● Microsoft Core XML Services (MSXML) 6.0

● Microsoft XML Paper Specification Essentials Pack 1.0

Color profiling
Color calibration provides consistent colors, but consistent colors are not necessarily accurate. For
instance, if your printer prints all colors as black, its colors may be consistent but they are not accurate.
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In order to print accurate colors, it is necessary to convert the color values in your files to the color values
that will produce the correct colors from your printer, your inks and your paper. An ICC color profile is
a description of a printer, ink and paper combination that contains all the information needed for these
color conversions.

When you have defined and calibrated a new paper type, the printer is ready to create a ICC profile for
use with your paper, which will allow you to print on it with the best possible color accuracy. Alternatively,
if your paper type is already known to the printer, you already have an appropriate ICC profile for use
with it.

Create your own profile
You can create a color profile easily by using the HP Color Center: select Paper Preset
Management > Profile Paper. The printer helps you by prompting for information about the paper, then
creates and installs the new profile automatically.

The process takes about 15–20 minutes and consists of the following steps.

1. A profiling chart is printed, which contains patches of each ink used in your printer. Unlike a
calibration chart, most of the patches contain combinations of more than one ink.

The printer chooses automatically between two profile charts:

● An A3 or B format for cut sheets

● A roll-paper format that minimizes paper use by printing across the full width of the roll

2. The chart is allowed to dry for a period of time that depends on the paper type, so that the colors
have time to stabilize.

NOTE: If you would like to use a longer drying time, you can ask the HP Color Center to create
the chart without going on to create a profile (Windows: Print target only; Mac OS: Print ICC
profiling chart). Then, later, when the chart is completely dry, you can restart the HP Color Center
and ask it to create a profile using the chart you have already created (Windows: Create ICC profile
from a target that has already been printed; Mac OS: Scan ICC profiling chart and create ICC
profile). In this case the spectrophotometer takes a while to warm up before it is ready to scan.

3. The chart is scanned and measured using the HP Embedded Spectrophotometer.
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NOTE: Chart measurement may not be successful if you load the chart as a single sheet without
skew check.

4. From the measurements made by the spectrophotometer, the printer calculates the ICC profile for
your printer, inks and paper type.

5. The new ICC profile is stored in the correct system folder on your computer, where your application
programs can find it.

The profile is also stored in the printer, so that other computers connected to the same printer can
copy it. The HP Printer Utility will notify you if your printer has profiles that are not yet stored on
your computer.

NOTE: Some applications may need to be closed and restarted in order to use a profile that has just
been created.

You can profile a photo paper with the gloss enhancer on or off. The two profiles will be different, so you
are recommended to save them under different names.

Color measurement
You can also create a color profile by using a third-party profiling program and the Color Measurement
facility. To begin Color Measurement:

● Using the HP Printer Utility for Windows, select Color Center > Paper Preset Management >
Color Measurement.

● Using the HP Printer Utility for Mac OS, select HP Color Center > Paper Preset Management.
Select the paper type, then press the  button and select Color Measurement from the popup
menu.

Continue with the following steps.

1. Choose the workflow that you want to use from the following options:

● Print and measure a color chart performs printing and measurement in a single process.
You can choose whether to use gloss enhancer and how much drying time to allow.

● Print a color chart for later measurement assumes that you will measure the printed chart
at some later time to complete the process. You can choose whether to use gloss enhancer.

● Measure a previously printed color chart completes the process if you have a color chart
ready for measurement. Load the chart in the correct direction as indicated by the arrows,
loading multiple pages in the correct order, and do not cut the paper.

● Export a color chart as a TIFF for printing externally allows you to use a different program
(a RIP, for example) to print the color chart. Do not modify the TIFF file in any way before
printing it. The printed chart should be exactly the correct size; the simplest way to achieve
this is to print it on a paper size larger than the chart and then cut the paper after printing as
indicated by the crop marks.

2. If printing a chart, select one of the available charts.

3. If measuring a chart, select the characteristics of the measurements file: what sort of information
it should contain (CGATS and MonacoPROFILER formats are supported), and where the file
should be saved.

NOTE: Chart measurement may not be successful if you load the chart as a single sheet without
skew check.

4. Open the measurements file with your profiling program.
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NOTE: The printer's spectrophotometer measures from 400 to 700 nm in steps of 20 nm. All other
measurement types are interpolated.

Install a profile
If you have obtained an ICC profile through other means than using the printer's built-in profiling
software, for instance from the Internet or from a third-party profiling software package, you can still
install it for use with your printer and paper.

1. Go to the HP Color Center in the HP Printer Utility. Select Paper Preset Management > Install
Profile.

2. Select the paper type that you will use with the ICC profile, and select the file containing the ICC
profile.

NOTE: ICC profile file names have the extensions ".icc" (for International Color Consortium) or
".icm" (for Image Color Matching).

3. Check the ICC profile name and settings that will be installed. Click Next.

4. The ICC profile is installed in your computer and will be available to use in your applications.

Export a profile
An ICC profile associated with a paper type can be exported, enabling it to be used on a different printer
or with a different paper preset..

1. Go to the HP Color Center in the HP Printer Utility. Select Paper Preset Management > Export
ICC Profile.

2. Select the paper type and the ICC profile to be exported.

3. Choose the pathname of the folder where the ICC profile will be saved in your computer.

4. The ICC profile file is saved in the specified folder.

Restore an original profile
The ICC profile settings in a paper preset can be restored to their original values. This will remove any
ICC profile that you have associated with the selected paper and restore the default ICC profile provided
by HP.

1. Go to the HP Color Center in the HP Printer Utility. Select Paper Preset Management > Restore
Factory ICC Profile.

2. Select the paper type whose ICC profile you want to restore. Click Restore.

Profile your monitor
You are also recommended to calibrate and profile your monitor (display device), so that the colors you
see on the screen are more closely related to those you see on your prints. There are two ways to do
this:

● Use the facilities provided with your operating system. From the HP Color Center, select How To
Calibrate Your Display for further information.

● Use the HP Advanced Profiling Solution, which will give more accurate results. See HP Advanced
Profiling Solution on page 109.
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Advanced profiling
To meet advanced color profiling needs, HP offers an optional Advanced Profiling Solution with software
and monitor-calibration hardware at much lower cost than competing solutions. See HP Advanced
Profiling Solution on page 109.

Color management options
The aim of color management is to reproduce colors as accurately as possible on all devices: so that,
when you print an image, you see very similar colors as when you view the same image on your monitor.

There are two basic approaches to color management for your printer:

● Application-Managed Colors: in this case your application program must convert the colors of
your image to the color space of your printer and paper type, using the ICC profile embedded in
the image and the ICC profile of your printer and paper type.

● Printer-Managed Colors: in this case your application program sends your image to the printer
without any color conversion, and the printer converts the colors to its own color space using a set
of stored ICC profiles. This method is somewhat less versatile and adaptable than Application-
Managed Colors, but it is a little simpler and faster, and can produce good results with standard
HP paper types.

There are only two color spaces that the printer can convert to its own color space using the stored
profiles: Adobe RGB and sRGB if you are using Windows, Adobe RGB if you are using Mac OS.
In addition, you can use ColorSync.

ColorSync is the Mac OS built-in Color Management System; so, when you select ColorSync, color
management is performed by Mac OS, and it is done based on the ICC profiles of the specified
paper type. ColorSync is available with the PCL3 driver only.

ColorSync can be selected under Mac OS X 10.4 from the Paper Type/Quality panel: select
the Color tab, then select Use Embedded (ICC/ColorSync) from the Source Profile drop-down
list. Under Mac OS X 10.5, ColorSync can be selected from the Color Matching panel.

You are recommended to consult the Knowledge Center at http://www.hp.com/go/z3200/
knowledgecenter/ to see how to use the color management options of your particular application.

To choose between Application-Managed Colors and Printer-Managed Colors:

● In the Windows driver dialog: select the Color tab.

● In the Mac OS Print dialog: select the Paper Type/Quality panel, then Color.

● In some applications: you can make this choice in the application.
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Color management example with Photoshop
In this example, you have an Adobe RGB image that you want to print from Photoshop. There are three
ways of doing it.

● Select Let Photoshop determine colors in Photoshop. Select Application-Managed Colors in
the printer driver. Color management is done in Photoshop. This is the recommended way.

● Select Let printer determine colors in Photoshop. Select Printer-Managed Colors and the sRGB
profile in the printer driver. Photoshop converts the image from Adobe RGB to sRGB and sends it
to the printer. Color management is done in the printer. Unfortunately, conversion to sRGB results
in a loss of gamut, but Photoshop cannot be prevented from converting to sRGB when Let printer
determine colors is selected.

● Select No color management in Photoshop. Select Printer-Managed Colors and the AdobeRGB
profile in the printer driver. Photoshop does not perform any conversion, there is no loss of gamut,
and color management is done in the printer. However, this method will not work if you are using
synchronized color management in Photoshop (see below).

Synchronized color management with Photoshop
If you are using Adobe Photoshop CS2 for Mac OS, or Adobe Photoshop CS3 for Windows, or later
versions, the color management options can be automatically synchronized between Photoshop and
the driver.

● If you select Let Photoshop determine colors or No color management in Photoshop,
Application-Managed Colors is automatically selected in the driver.

● If you select Let printer determine colors in Photoshop, Printer-Managed Colors is
automatically selected in the driver.

To enable this Photoshop synchronization under Windows XP, you must download and install the
following free software packages from Microsoft's Web site:

● Microsoft Core XML Services (MSXML) 6.0

● Microsoft XML Paper Specification Essentials Pack 1.0

Color adjustment options
The aim of color management is to print accurate colors. If you perform color management correctly,
then you should be able to print accurate colors with no need of any manual color adjustments.

However, manual adjustments may be useful in the following situations:

● If your color management is not working correctly for some reason

● If you want colors that are subjectively pleasing rather than accurate

The printer driver provides different adjustment facilities depending on whether you are printing in color
or in grayscale.

Printing in color
You can adjust the colors of your print in similar ways under Windows and Mac OS:

● In the Windows driver dialog: select the Color tab, ensure that the Advanced color
adjustments box is checked, then press the Settings button beside it.

● In the Mac OS Print dialog: select the Paper Type/Quality panel, then Lightness and Hue.
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Under either operating system, you will then be able to make adjustments using a lightness slider and
three color sliders.

● The lightness slider simply makes the whole print lighter or darker.

● The color sliders can be used to fade or emphasize each of the primary colors in the print. The
primary colors may be red, green and blue; or cyan, magenta and yellow; depending on the color
model used in the image.

The Reset button restores each slider to its default central position.

Printing in grayscale
You can adjust the gray balance of your print in similar ways under Windows and Mac OS:

● In the Windows driver dialog: select the Color tab, ensure that the Advanced color
adjustments box is checked, then press the Settings button beside it.

● In the Mac OS Print dialog: select the Paper Type/Quality panel, then Gray balance.

Under either operating system, you will then be able to make adjustments using separate controls for
highlights, midtones and shadows.

● The lightness slider simply makes the whole print lighter or darker. This slider is available under
Windows in the same window as the other grayscale controls; it is available under Mac OS by
selecting Lightness and Hue.

● The zone definition sliders can be used to define what you mean by highlight, midtone and shadow.

● The other controls for highlight, midtone and shadow can be used to adjust the gray balance of
highlights, midtones and shadows respectively.

The Reset button restores each control to its default setting.

Color management scenarios
The following step-by-step instructions for specific printing jobs using specific software are similar to
those you can find in HP's Knowledge Center on the Web. You are recommended to consult the
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Knowledge Center at http://www.hp.com/go/z3200/knowledgecenter/ for further examples and for the
most up-to-date information.

Print a color photo for an exhibition (Photoshop, Mac OS)
This example uses Adobe Photoshop CS2 under Mac OS X and the color management is done by
Photoshop.

1. Initial recommendations:

● Choose an appropriate paper type for the purpose.

● The paper type should be calibrated and profiled with the printer and the print-quality level
that you intend to use. See Color calibration on page 60 and Color profiling on page 61.

● For a correct preview of the printed image, the monitor should also be profiled.

2. Open Adobe Photoshop CS2.

3. From the Edit menu, select Color Settings.

● Make sure that More Options are displayed.

● Color Management Policies: select Preserve Embedded Profiles.

● Profile Mismatches: check Ask When Opening and Ask When Pasting.

● Missing Profiles: check Ask When Opening.

● Conversion Options > Intent: select Perceptual.

● Click OK.
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4. From the File menu, select Open to open the image.

● If the document has an embedded color profile that does not match the current working space,
select Use the embedded profile. Otherwise, select Assign working space; in this case, if
the displayed image does not look correct, try assigning it to other color spaces with Edit >
Assign Profile (try sRGB, Adobe RGB, ColorMatch RGB and others) until you are satisfied.

● Click OK.

5. From the File menu, select Print with Preview.

● Select Page Setup.

◦ Format for: select the printer (for example, HP Designjet Z3200 Photo 24in).

◦ Paper Size: select the size of the paper that is currently loaded into the printer.

◦ Orientation: select the orientation of your image on the paper.

◦ Click OK.

● Set the Position and the Scaled Print Size you need.

● Make sure that More Options are displayed.

● Select the Color Management tab.

◦ Print: select Document.

◦ Options > Color Handling: select Let Photoshop Determine Colors.

◦ Options > Printer Profile: select the right profile for your printer and paper type.

ENWW Color management scenarios 69

C
ol

or
 m

an
ag

em
en

t



◦ Options > Rendering Intent: select Perceptual.

● Click Print.

6. Choose driver settings.

● Printer: select the printer (for example, HP Designjet Z3200 Photo 24in).

● Select Paper Type/Quality from the drop-down menu, then select the Paper tab.

◦ Paper Type: select the paper type that is currently loaded into the printer.

◦ Quality Options: select Standard and drag the slider to Quality.

● Click Print.

Print a black-and-white photo for an exhibition (Photoshop, Mac OS)
This example uses Adobe Photoshop CS2 under Mac OS X and the color management is done by the
printer.

NOTE: Application-managed colors could be used in this example, exactly as in the previous example.
However, printer-managed colors will be used this time, in order to illustrate both methods of color
management.
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The recommended approach to creating a black-and-white image is to take a color image and convert
it to grayscale in an image editing program such as Photoshop. In this scenario, however, this conversion
will take place in the printer. If you want to convert a color image to black-and-white in Photoshop CS2,
you have to go through the optional step 5.

1. Initial recommendations:

● Choose an appropriate paper type for the purpose.

● The paper type should be calibrated with the printer and the print-quality level that you intend
to use. See Color calibration on page 60.

● For a correct preview of the printed image, the monitor should also be profiled.

2. Open Adobe Photoshop CS2.

3. From the Edit menu, select Color Settings.

● Make sure that More Options are displayed.

● Color Management Policies: select Preserve Embedded Profiles.

● Profile Mismatches: check Ask When Opening and Ask When Pasting.

● Missing Profiles: check Ask When Opening.

● Conversion Options > Intent: select Perceptual.

● Click OK.
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4. From the File menu, select Open to open the image.

● If the document has an embedded color profile that does not match the current working space,
select Use the embedded profile. Otherwise, select Assign working space; in this case, if
the displayed image does not look correct, try assigning it to other color spaces with Edit >
Assign Profile (try sRGB, Adobe RGB, ColorMatch RGB and others) until you are satisfied.

● Click OK.

5. (Optional) Use Photoshop to convert the image to grayscale. The simple way is to go to the
Image menu and select Mode > Grayscale.

Alternatively, you can go to the Image menu and select Adjustments > Channel Mixer, to choose
the percentage contribution of each color channel to the grayscale image, as follows:

a. Check Monochrome.

b. Drag any source channel's slider to the left to decrease the channel's contribution to the output
channel or to the right to increase it, or enter a value between -200% and +200% in the text
box (for example: 30% Red, 59% Green, 11% Blue). Using a negative value inverts the source
channel before adding it to the output channel.

c. Drag the slider or enter a value for the Constant option. This option adds a black or white
channel of varying opacity: negative values act as a black channel, positive values act as a
white channel.

d. Click OK.
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6. From the File menu, select Print with Preview.

● Select Page Setup.

◦ Format for: select the printer (for example, HP Designjet Z3200 Photo 24in).

◦ Paper Size: select the size of the paper that is currently loaded into the printer.

◦ Orientation: select the orientation of your image on the paper.

◦ Click OK.

● Set the Position and the Scaled Print Size you need.

● Make sure that More Options are displayed.

● Select the Color Management tab.

◦ Print: select Document.

◦ Options > Color Handling: select Let Printer Determine Colors.

◦ Options > Rendering Intent: select Perceptual.

● Click Print.

7. Choose driver settings.

● Printer: select the printer (for example, HP Designjet Z3200 Photo 24in).

● Select Paper Type/Quality from the drop-down menu, then select the Paper tab.

◦ Paper Type: select the paper type that is currently loaded into the printer.
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◦ Quality Options: select Standard and drag the slider to Quality.

● Select the Color tab.

◦ Select Print in Grayscale.

TIP: If you experience bronzing with these options, see Bronzing on page 127.

◦ Under Color Management, select Printer Managed Colors, and then select Use Adobe
RGB (1998) from the source profile list.

● Click Print.

Print a digital album (Aperture, Mac OS)
This example uses Apple Aperture under Mac OS X and the color management is done by Aperture.

1. Initial recommendations:

● Choose an appropriate paper type for the purpose.

● The paper type should be calibrated and profiled with the printer and the print-quality level
that you intend to use. See Color calibration on page 60 and Color profiling on page 61.

● For a correct preview of the printed image, the monitor should also be profiled.

2. Open Apple Aperture.

3. If you haven't already created a project for this album, go to the File menu and select New
Project, then name the project. Select the new project in the projects menu (on the left), then go
to the File menu and select Import > Folders into a Project.
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4. Select the images you want to use, then go to the File menu and select New From Selection >
Book.

● Theme list: select a theme in the list to see a preview of its design on the right.

● Book Size popup menu: select the physical size of the book.

● Click Choose Theme, and rename the book album.

5. If you like, change the page layout and customize it. You can add photo and text boxes, modify the
box positions and the text styles.

6. You can let Aperture place your images into the book automatically (select Autoflow Unplaced
Images from the Book Actions menu ), or you can place them manually by drag and drop.
Furthermore:

● You can scale, crop and pan the image.

● You can set an image as page background and apply wash.

7. Print your book, using the Print button in the Book Layout Editor.

● Presets Name list: select your book preset.

● Select Copies and Pages to print.

● Paper Size: select the paper size on which you want to print the job.
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● Orientation: select the orientation of your image on the paper.

● ColorSync Profile: select the correct color profile for the printer and paper that you will use.

● Select Black Point Compensation.

● Gamma: Because computer displays are illuminated, images displayed on computers tend
to look more luminous than when printed. Increasing the Gamma from the default of 1.0 can
compensate for this. Usually, a setting 1.1 to 1.2 is adequate.

8. Click the Printer Settings button.

● Printer: select the printer (for example, HP Designjet Z3200 Photo 24in).

● Select Paper Type/Quality from the drop-down menu, then select the Paper tab.

◦ Paper Type: select the paper type that is currently loaded into the printer.

◦ Quality Options: select Standard and drag the slider to Quality.

● Select the Color tab.

◦ Select Print in Color.
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◦ Under Color Management, select Application Managed Colors.

● Click Print.
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7 Retrieving printer usage information

● Get printer accounting information

● Check printer usage statistics

● Check ink and paper usage for a job

● Cost accounting

● Request accounting data by E-mail
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Get printer accounting information
There are various different ways of getting accounting information from your printer.

● View printer usage statistics for the whole lifetime of the printer, see Check printer usage
statistics on page 79.

● View ink and paper usage for each of your recent jobs by using the HP Printer Utility or the front
panel, see Check ink and paper usage for a job on page 79. If the HP Printer Utility is not available,
see Access the HP Printer Utility on page 19.

● Use a third-party application to request printer status, printer usage or job accounting data from
the printer through the Internet. The printer provides data in XML to the application whenever
requested. HP provides a Software Development Kit to facilitate the development of such
applications.

Check printer usage statistics
There are two ways to check your printer's usage statistics.

NOTE: The accuracy of the usage statistics is not guaranteed.

Printer statistics with the HP Printer Utility
1. Start the HP Printer Utility, see Access the HP Printer Utility on page 19.

2. Go to the Usage window to view the total printer usage.

● Under Windows, go to the Overview tab and click Printer usage.

● Under Mac OS, select Information > Printer Usage and click the Start button.

Printer statistics with the Embedded Web Server
1. Access the Embedded Web Server, see Access the Embedded Web Server on page 19.

2. Go to the Main tab and select Usage

Check ink and paper usage for a job
There are two ways to check ink and paper usage for a job.

NOTE: The accuracy of the usage statistics is not guaranteed.

Ink and paper statistics with the HP Printer Utility
1. Start the HP Printer Utility, see Access the HP Printer Utility on page 19.

2. Go to the Accounting window to view information regarding the most recent jobs.

● Under Windows, go to the Job Accounting tab.

● Under Mac OS, select Information > Job Accounting and click the Look Up button.

Printer statistics with the Embedded Web Server
1. Access the Embedded Web Server, see Access the Embedded Web Server on page 19.

2. Go to the Main tab and select Accounting.
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Cost accounting
The usage statistics tell you the quantities of supplies that have been used. If you would like to assign
a cost per unit to each item, your statistical report can include costs as well as quantities.

1. Access the Embedded Web Server, see Access the Embedded Web Server on page 19.

2. Go to the Main tab.

3. Select Accounting > Cost assignments.

Request accounting data by E-mail
1. In the Embedded Web Server's Setup tab, select E-mail server. Enter the address of the SMTP

server that will be used to send e-mail messages, and e-mail address of the printer. The latter is a
fake address that is required only so that the receiver of the messages can recognize where they
are coming from.

2. Also in the Setup tab, select Printer settings and open the Accounting section. You must enter
an E-mail address to which accounting files will be sent, and the frequency with which they will be
sent (specified as a number of days or as a number of prints).

3. When you have completed the above steps, the printer will send accounting data by E-mail with
the frequency that you specified. The data are provided in XML and can easily be interpreted by a
third-party program. The data provided on each job include the job name, the account ID if any,
the user name, when the job was submitted, when the job was printed, the printing time, the type
of image, the number of pages, the number of copies, the paper type and size, the amount of each
color of ink used, and various other attributes of the job.

You can download an Excel template from HP Designjet Online (http://www.hp.com/go/graphic-arts/)
that will enable you to display the XML data more readably in the form of a spreadsheet.

Analysis of the accounting data will enable you to bill customers precisely and flexibly for the use of your
printer. You can, for instance:

● Bill each customer for the total amount of ink and paper used by that customer over a particular
period.

● Bill each customer separately per job.

● Bill each customer separately for each project, broken down by job.
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8 Handling ink cartridges and printheads

● About the ink cartridges

● Check ink cartridge status

● Remove an ink cartridge

● Insert an ink cartridge

● About the printheads

● Check printhead status

● Remove a printhead

● Insert a printhead
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About the ink cartridges
Ink cartridges store the ink and are connected to the printheads, which distribute the ink on the paper.
You can purchase 130 ml ink cartridges for your printer, see Accessories on page 101.

CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive
devices (see the Glossary on page 160). Avoid touching pins, leads and circuitry.

Check ink cartridge status
To view the ink levels of your ink cartridges, press the View ink level key on the front panel.

To get more information on your ink cartridges, you can use the front panel ink menu or the HP Printer
Utility.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages
on page 138.

Ink menu procedure
1.

From the front panel, select the Ink menu icon , then Ink cartridge information.

2. Select the cartridge on which you want information.

3. The front panel displays information about that cartridge.

HP Printer Utility procedures
● In the HP Printer Utility for Windows, go to the Overview tab, each cartridge's status is under

Supply Status > Cartridges.

● In the HP Printer Utility for Mac OS, select Printer Status in the Information group.

Remove an ink cartridge
There are three occasions when you need to remove an ink cartridge.

● The ink level in the cartridge is very low and you want to replace it with a full cartridge for unattended
printing (you can use up the remaining ink in the first cartridge at a more convenient time).

● The ink cartridge is empty or faulty, and you must replace it to continue printing.

● The ink cartridge has expired.

TIP: Remove an ink cartridge only if you are ready to insert another one.

CAUTION: Do not try to remove an ink cartridge while printing.
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CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

1.
From the front panel, select the Ink menu icon , then Replace ink cartridges.

2. Open the ink cartridge cover completely. Gloss enhancer, gray, blue, green, magenta and yellow
are in the left side, while light magenta, light cyan, photo black, light gray, matte black and red are
in the right side.

3. Grip the cartridge you wish to remove.
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4. Pull the cartridge straight up.

NOTE: Avoid touching the end of the cartridge that is inserted into the printer, as there may be
ink on the connection.

NOTE: Avoid storing partially used ink cartridges.

5. The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge
1. Before removing the cartridge from its wrapping, shake it vigorously.

2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters
(in these illustrations, M for magenta) marking the empty slot, matches the letter or letters on the
cartridge label.
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3. Insert the ink cartridge into its slot.

4. Push the cartridge into the slot until it snaps into position. You should hear a beep and see
confirmation that the cartridge has been inserted.

If you have difficulty, see Cannot insert an ink cartridge on page 138.

5. When all cartridges have been inserted, close the cover.

6. The front-panel display confirms that all cartridges have been correctly inserted, press the OK key
on the front panel.

About the printheads
The printhead are connected to the ink cartridges and jet ink onto the paper.
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CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices
(see the Glossary on page 160). Avoid touching pins, leads and circuitry.

Check printhead status
The printer automatically checks and services the printheads after each print. Follow the steps below
to get more information on your printheads.

1.
From the front panel, select the Ink menu icon , then Printhead information.

2. Select the printhead on which you want information.

3. The front panel displays information about that printhead.

You can also get most of this information without leaving your computer by using the HP Printer Utility.

For an explanation of the printhead status messages, see Printhead status messages on page 144.

NOTE: If the warranty status is See warranty note, this indicates that non-HP ink is being used. Printer
service or repairs required as a result of using "non-HP" ink are not covered under warranty. See the
Legal Information document for detailed warranty implications.

Remove a printhead
CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

CAUTION: Printhead replacement must be performed with the printer powered on.

1.
From the front panel, select the Ink menu icon , then Replace printheads.

2. The printer moves the carriage into the correct position.

CAUTION: If the carriage is left in the removal position for more than three minutes without
inserting or removing any printheads, it tries to move back to its normal position in the right-hand
end.
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3. When the carriage has stopped moving, the front-panel display asks you to open the window.

4. Locate the carriage on the right side of the printer.

5. To Pull the handle up and toward you to release the wire loop.

6. Push the handle back to raise the carriage lid.

7. This gives you access to the printheads.
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8. To remove a printhead, lift up the blue handle.

9. Using the blue handle, use steady force to disengage the printhead.

10. Pull the blue handle upward until the printhead is released from the carriage.

CAUTION: Do not pull abruptly because this can damage the printhead.

11. The front-panel display identifies the missing printhead.

Insert a printhead
1. If the printhead is new, shake the printhead vigorously before removing the protective caps.
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2. Remove the orange protective caps by pulling them down.

3. The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check
that the colored label on the printhead matches the colored label of the carriage slot into which the
printhead is to be inserted.

4. Insert the new printhead into its correct slot in the carriage.

CAUTION: Insert the printhead slowly and vertically, straight down. It may be damaged if you
insert it too fast, or at an angle, or if you rotate it as you insert it.
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5. Push down as indicated by the arrow shown below.

CAUTION: When installing the new printhead there may be some resistance, so you need to
press it down firmly but smoothly. You should hear a beep and see confirmation on the front-panel
display that the printhead has been inserted. If you have difficulty, see Cannot insert a printhead
on page 138.

6. Insert any other printheads, that need to be installed, with the same procedure, then close the
carriage lid.

7. Ensure the end of the blue handle catches the wire loop on the near side of the carriage.
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8. Lower the handle to rest on the carriage lid.

When all the printheads have been inserted correctly and are accepted by the printer, the printer
beeps.

NOTE: If the printer does not beep when you insert the printhead and the Replace message
appears on the front-panel display, the printhead may need to be reinserted.

9. Close the window.

10. The front-panel display confirms that all printheads are correctly inserted. The printer starts
checking and preparing the printheads. The default routine process, when all printheads are
changed, takes 35 minutes. If the printer finds problems in preparing the printheads, it takes longer,
up to 80 minutes. For a single printhead insertion, the times vary between 25 and 45 minutes. After
all printheads are checked and prepared, the printhead realignment procedure runs automatically
if paper is loaded, see Align the printheads on page 142.
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9 Maintaining the printer

● Check printer status

● Clean the exterior of the printer

● Replace the cutter

● Maintain the ink cartridges

● Move or store the printer

● Update the firmware

● Update the software

● Change the battery

● Printer maintenance kits

● Secure Disk Erase
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Check printer status
You can check the current status of the printer in various ways:

● If you start the HP Printer Utility and select your printer, you see a page of information describing
the status of the printer and its paper and ink supplies.

● If you access the Embedded Web Server, you see information about the general status of the
printer. The Supplies page in the Main tab describes the status of the paper and ink supplies.

● The status screen of the printer's front panel notifies you of any current problems affecting the
printer as a whole. You can also request information about:

◦ The currently loaded paper, with the View loaded paper key

◦ The ink levels, with the View ink levels key

◦
The ink cartridges, by selecting the Ink menu icon  and then Ink cartridge information

◦
The printheads, by selecting the Ink menu icon  and then Printhead information

Clean the exterior of the printer
Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid
soap.

WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before
you clean it. Do not let water get inside the printer.

CAUTION: Do not use abrasive cleaners on the printer.

Replace the cutter
The cutter may need to be replaced once or twice during the life of the printer, depending on the total
amount and thickness of paper used. The front panel advises when replacement is due. If you do not
replace the cutter immediately, the printer continues working normally, but the front panel continues to
remind you about the cutter.

To replace the cutter:

1. If there is paper loaded in the printer, unload it.

2.
At the front panel, select the Setup menu icon , then Advanced > Resets > Reset cutter life
counter.

3. After a brief pause, the printer turns itself off. The printhead carriage is parked on the right-hand
side of the printer, and the cutter on the left-hand side.

WARNING! There is a risk of electric shock if you attempt to replace the cutter with the printer
turned on.
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4. Lift the ink cartridge cover on the left-hand side of the printer.

5. Press the button behind the ink cartridges to release the cover of the left-hand end of the printer.

6. Remove the left end cover.
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7. Unscrew and remove the cutter stop using the TORX PLUS screwdriver provided with the new
cutter. The screw is captive and will not fall out.

8. Remove the old cutter.

9. Take the new cutter from the maintenance kit and move the plunger at the top slowly back and
forth within its housing to check that it moves freely.
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10. Slide the new cutter into position on the cutter rail.

The two wheels on the bottom of the cutter should engage the central ridge on the cutter rail, and
the two bushing guides should fit into the groove in the upper part of the cutter rail.

Check that the cutter runs smoothly up and down the rail. You can leave it anywhere on the rail;
the printer will park it correctly later.

11. Fit the cutter stop onto the end of the cutter rail, holding it there with one hand while you tighten
the screw with the screwdriver in your other hand.
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12. Put the left end cover back on the printer, aligning the protrusions with the holes in the printer.

13. Close the ink cartridge cover.

14. At the front panel, turn the printer back on. The printer checks that the cutter has been correctly
installed. Look at the front panel and follow its instructions if there is any problem.

Maintain the ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to
maintain the best print quality, replace a cartridge when it reaches its expiration date. The printer's front
panel notifies you when any cartridge reaches its expiration date.

You can also check a cartridge's expiration date at any time: see Check printer status on page 93.

See also Handling ink cartridges and printheads on page 81.

Move or store the printer
If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To prepare
the printer, follow the instructions below.

1. Do not remove the ink cartridges or printheads.

2. Make sure that no paper is loaded.

3. Make sure that the printer is idle.

4. Disconnect any cables connecting the printer to a network or a computer.
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5. Before transporting the printer, secure the rear tray in the closed position with tape. Otherwise, the
tray could open and perhaps break and fall out of the printer.

If you need to leave the printer turned off for a long time, follow the additional steps below.

1. Turn off the power using the Power key on the front panel.

2. Also turn off the power switch at the rear of the printer.

3. Disconnect the printer's power cable.

CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious
damage.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and
prepare the printheads. Preparing the printheads normally takes just over a minute. However, if the
printer has been off for a six weeks or more, preparing the printheads could take up to an hour.

If the printer remains off for a long period of time, the printheads may become unusable. In this case,
you need to replace the printheads with new ones.

Update the firmware
The printer's various functions are controlled by software that resides in the printer, otherwise known
as firmware.

From time to time firmware updates will be available from Hewlett-Packard. These updates increase the
printer's functionality and enhance its features.

Firmware updates can be downloaded from the Internet and installed in your printer in the following
ways; you can choose whichever you find most convenient.

● Using the HP Printer Utility for Windows, select your printer, the Support tab, and then Firmware
Update.

● Using the HP Printer Utility for Mac OS, select Firmware Update in the Support group.

● Using your printer's Embedded Web Server, select the Setup tab and then Firmware update.

In each case, follow the instructions on your screen to download the firmware file and store it on your
hard disk. Then select the downloaded file and click Update.
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If you experience very slow progress while uploading the firmware file to the printer, the reason could
be that you are using a proxy server. In that case, try bypassing the proxy server and accessing the
Embedded Web Server directly.

● In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and check the Bypass proxy server for local addresses box. Alternatively, for more
precise control, click the Advanced button and add the printer's IP address to the list of exceptions,
for which the proxy server is not used.

● In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change
Settings button. Add the printer's IP address or its domain name to the list of exceptions, for which
the proxy server is not used.

The firmware includes a set of the most commonly used paper presets. Extra paper presets can be
downloaded separately; see Paper presets on page 35.

Update the software
You are recommended to use HP Proactive Support (see HP Proactive Support on page 154) to keep
your printer driver and other printer software up to date. Alternatively, go to http://www.hp.com/go/z3200/
drivers/.

Change the battery
When the front panel announces that the real-time clock is not working, you must change the battery.
You need a lithium battery, model CR2032. To replace the battery, follow these steps.

1. Turn the printer off and unplug the cable. Unplug any network or USB cables.

2. Loosen the screws that attach the formatter to the printer with your fingers, or with the help of a flat
screwdriver.

3. Locate the round, flat battery in the formatter.

4. Push the battery slightly to one side and then pull it up. A little force may be required.

5. Insert the new battery by pressing it down.

6. Insert the formatter into the printer by pressing it down, and tighten the screws.

7. Reconnect the cables and turn the printer on.

Printer maintenance kits
Three maintenance kits are available for your printer, containing components that may need to be
replaced after long use. When one of them is needed, a message is displayed on the front panel and
by the HP Printer Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 154)
and request the maintenance kit. Two of the kits are installed by service engineers only; the third consists
of a replacement cutter, which you can install yourself (see Replace the cutter on page 93).

Secure Disk Erase
The printer's hard disk is used as a temporary storage area for print jobs. The Secure Disk Erase facility
can completely erase your information from the hard disk to protect it from unauthorized access. You
can choose to erase particular files, or the whole hard disk.
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Secure Disk Erase provides three different levels of security:

● Non-Secure Fast Erase: all pointers to the information are erased. The information itself remains
on the hard disk until the disk space it occupies is needed for other purposes, and it is then
overwritten. While it remains on the disk, it is difficult for most people to access, but may be
accessed using software designed for the purpose. This is the normal method in which files are
erased on most computer systems; it is the fastest method but the least secure.

● Secure Fast Erase: all pointers to the information are erased, and the information itself is also
overwritten with a fixed character pattern. This method is slower than Non-Secure Fast Erase, but
more secure. It may still be possible to access fragments of the erased information by using special
tools to detect residual magnetic traces.

● Secure Sanitizing Erase: all pointers to the information are erased, and the information itself is
repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the
slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of
Defense 5220-22.m requirements for clearing and sanitization of disk media. This is the default
security level when using Secure Disk Erase.

Secure Disk Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based
print management software: see http://www.hp.com/go/webjetadmin/.

If you have difficulty in using Secure Disk Erase from Web JetAdmin, please contact HP Support:
see Contact HP Support on page 154.

Before choosing to erase the whole hard disk, you should be aware of the following considerations:

● You may be asked to restart the printer several times during the process, which will take about 6
hours with Secure Disk Erase or 24 hours with Secure Sanitizing Erase.

● The demo prints available from the front panel will be deleted and not restored.
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10 Accessories

● How to order supplies and accessories

● Introduction to the accessories
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How to order supplies and accessories
There are two alternative ways to order supplies or accessories for your printer:

● Visit http://www.hp.com/go/z3200/supplies/ or http://www.hp.com/go/z3200/accessories/ on the
Web.

● Contact your local dealer.

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies
The following ink supplies can be ordered for your printer.

Table 10-1  Ink cartridges

Cartridge Part number

HP 70 Matte Black 130 ml Ink Cartridge C9448A

HP 70 Photo Black 130 ml Ink Cartridge C9449A

HP 70 Gray 130 ml Ink Cartridge C9450A

HP 70 Light Gray 130 ml Ink Cartridge C9451A

HP 70 Magenta 130 ml Ink Cartridge C9453A

HP 70 Yellow 130 ml Ink Cartridge C9454A

HP 70 Light Magenta 130 ml Ink Cartridge C9455A

HP 73 Chromatic Red 130 ml Ink Cartridge CD951A

HP 70 Green 130 ml Ink Cartridge C9457A

HP 70 Blue 130 ml Ink Cartridge C9458A

HP 70 Gloss Enhancer 130 ml Ink Cartridge C9459A

HP 70 Light Cyan 130 ml Ink Cartridge C9390A

HP 70 Matte Black 130 ml Ink Cartridge Twin Pack CB339A

HP 70 Photo Black 130 ml Ink Cartridge Twin Pack CB340A

HP 70 Gray 130 ml Ink Cartridge Twin Pack CB341A

HP 70 Light Gray 130 ml Ink Cartridge Twin Pack CB342A

HP 70 Magenta 130 ml Ink Cartridge Twin Pack CB344A

HP 70 Yellow 130 ml Ink Cartridge Twin Pack CB345A

HP 70 Light Magenta 130 ml Ink Cartridge Twin Pack CB346A

HP 73 Chromatic Red 130 ml Ink Cartridge Twin Pack CD952A

HP 70 Green 130 ml Ink Cartridge Twin Pack CB348A

HP 70 Blue 130 ml Ink Cartridge Twin Pack CB349A

HP 70 Gloss Enhancer 130 ml Ink Cartridge Twin Pack CB350A

HP 70 Light Cyan 130 ml Ink Cartridge Twin Pack CB351A
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Table 10-2  Printheads

Printhead Part number

HP 70 Light Magenta & Light Cyan Printhead C9405A

HP 70 Magenta & Yellow Printhead C9406A

HP 70 Photo Black & Light Gray Printhead C9407A

HP 70 Blue & Green Printhead C9408A

HP 73 Matte Black & Chromatic Red Printhead CD949A

HP 70 Gloss Enhancer & Gray Printhead C9410A

Order paper
HP currently provides the following paper types for use with your printer.

NOTE: This list is likely to change over the course of time. For the latest information, see
http://www.hp.com/go/z3200/supplies/. For further background inforrmation, see http://www.hp.com/go/
z3200/paperpresets/.

Key to availability:

● (A) indicates papers available in Asia (excluding Japan)

● (E) indicates papers available in Europe, the Middle East and Africa

● (J) indicates papers available in Japan

● (L) indicates papers available in Latin America

● (N) indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

Table 10-3  Roll paper

Paper type g/m² Length Width Part numbers

Bond and Coated Paper

Super Heavyweight Plus Matte
Paper

210 100 ft = 30.5 m 24 in = 610 mm Q6626A (AEJLN)

36 in = 914 mm Q6627A (AEJLN)

42 in = 1067 mm Q6628A (AEJLN)

Heavyweight Coated Paper 131 100 ft = 30.5 m 24 in = 610 mm C6029C (AEJN)

36 in = 914 mm C6030C

42 in = 1067 mm C6569C

225 ft = 67.5 m 42 in = 1067 mm Q1956A (EN)

Universal Heavyweight Coated
Paper

120 100 ft = 30.5 m 24 in = 610 mm Q1412A (AEJN)

36 in = 914 mm Q1413A

42 in = 1067 mm Q1414A (AEJN)
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Paper type g/m² Length Width Part numbers

Coated Paper 90 150 ft = 45.7 m 16.54 in = 420 mm Q1443A (J)

23.39 in = 594 mm Q1442A (EJ)

24 in = 610 mm C6019B

33.11 in = 841 mm Q1441A (EJ)

36 in = 914 mm C6020B

42 in = 1067 mm C6567B

300 ft = 91.4 m 36 in = 914 mm C6980A

Inkjet Coated Paper 90 150 ft = 45.7 m 18 in = 458 mm Q7897A (ELN)

Universal Coated Paper 95 150 ft = 45.7 m 24 in = 610 mm Q1404A (AEJN)

36 in = 914 mm Q1405A (AEJN)

42 in = 1067 mm Q1406A

Bright White Inkjet Bond Paper 90 150 ft = 45.7 m 16.54 in = 420 mm Q1446A (J)

23.39 in = 594 mm Q1445A (EJ)

24 in = 610 mm C1860A (LN),
C6035A (AEJ)

33.11 in = 841 mm Q1444A (EJ)

36 in = 914 mm C1861A (LN),
C6036A (AEJ)

300 ft = 91.4 m 36 in = 914 mm C6810A

Universal Bond Paper 80 150 ft = 45.7 m 23.39 in = 594 mm Q8003A (AJ)

24 in = 610 mm Q1396A

36 in = 914 mm Q1397A

42 in = 1067 mm Q1398A

Fluorescent Yellow Coloured Paper 100 150 ft = 45.7 m 36 in = 914 mm Q1757A (E)

Yellow Coloured Paper 92 150 ft = 45.7 m 23.39 in = 594 mm Q6596A (E)

36 in = 914 mm Q1760A (EN)

Technical Paper

Natural Tracing Paper 90 150 ft = 45.7 m 16.54 in = 420 mm Q1440A (J)

23.39 in = 594 mm Q1439A (J)

24 in = 610 mm C3869A

33.11 in = 841 mm Q1438A (J)

36 in = 914 mm C3868A

Translucent Bond Paper 67 150 ft = 45.7 m 24 in = 610 mm C3860A (AJN)

36 in = 914 mm C3859A (LN)

Vellum Paper 75 150 ft = 45.7 m 24 in = 610 mm C3862A (N)

36 in = 914 mm C3861A (LN)

Film (Technical and Graphic)

Table 10-3  Roll paper (continued)
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Paper type g/m² Length Width Part numbers

Clear Film 174 75 ft = 22.9 m 24 in = 610 mm C3876A (AEJN)

36 in = 914 mm C3875A

Matte Film 160 125 ft = 38.1 m 24 in = 610 mm 51642A (AEJN)

36 in = 914 mm 51642B

High Gloss Polyester Film

White Matte Polyester Film 167 50 ft = 15.2 m 36 in = 914 mm Q1736A (AEN)

Photographic Paper

Professional Satin Photo Paper 300 50 ft = 15.2 m 24 in = 610 mm Q8759A

44 in = 1118 mm Q8840A

Premium Instant-dry Gloss Photo
Paper

260 50 ft = 15.2 m 18 in = 458 mm Q7990A

75 ft = 22.9 m 24 in = 610 mm Q7991A

100 ft = 30.5 m 36 in = 914 mm Q7993A

42 in = 1067 mm Q7995A

Premium Instant-dry Satin Photo
Paper

260 50 ft = 15.2 m 18 in = 458 mm Q8001A (ELN)

75 ft = 22.9 m 24 in = 610 mm Q7992A

100 ft = 30.5 m 36 in = 914 mm Q7994A

42 in = 1067 mm Q7996A

Universal Instant-dry Gloss Photo
Paper

190 100 ft = 30.5 m 24 in = 610 mm Q6574A

36 in = 914 mm Q6575A

42 in = 1067 mm Q6576A

200 ft = 61m 42 in = 1067 mm Q8754A (ELN)

Universal Instant-dry Semi-Gloss
Photo Paper

190 100 ft = 30.5 m 24 in = 610 mm Q6579A

36 in = 914 mm Q6580A

42 in = 1067 mm Q6581A

200 ft = 61m 42 in = 1067 mm Q8755A

Everyday Pigment Ink Gloss Photo
Paper

235 100 ft = 30.5 m 24 in = 610 mm Q8916A

36 in = 914 mm Q8917A

42 in = 1067 mm Q8918A

Everyday Pigment Ink Satin Photo
Paper

235 100 ft = 30.5 m 24 in = 610 mm Q8920A

36 in = 914 mm Q8921A

42 in = 1067 mm Q8922A

Premium Matte Photo Paper 210 100 ft = 30.5 m 24 in = 610 mm CG459A

36 in = 914 mm CG460A

Proofing Paper

Professional High-gloss Contract
Proofing Paper

200 100 ft = 30.5 m 18 in = 458 mm Q8664A (EN)

24 in = 610 mm Q8663A (EN)

Table 10-3  Roll paper (continued)
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Paper type g/m² Length Width Part numbers

Professional Semi-gloss Contract
Proofing Paper

235 100 ft = 30.5 m 18 in = 458 mm Q8049A (EN)

24 in = 610 mm Q7971A (EN)

36 in = 914 mm Q8909A (EN)

42 in = 1067 mm Q8910A (EN)

Premium Semi-gloss Proofing
Paper

240 100 ft = 30.5 m 18 in = 458 mm CG462A (E)

24 in = 610 mm CG463A (E)

42 in = 1067 mm CG490A (E)

Matte Proofing Paper 146 100 ft = 30.5 m 18 in = 458 mm Q7896A (EJN)

24 in = 610 mm Q1968A (AEJN)

Backlit Material

Premium Vivid Color Backlit Film 285 100 ft = 30.5 m 36 in = 914 mm Q8747A

42 in = 1067 mm Q8748A

Self-adhesive Material

Self-adhesive Indoor Paper 170 75 ft = 22.9 m 36 in = 914 mm Q1733A (EJN)

Universal Adhesive Vinyl 290 66 ft = 20.1 m 36 in = 914 mm Q8676A (EN)

42 in = 1067 mm Q8677A (EN)

Matte Adhesive-back Polypropylene 225 70 ft = 21.3 m 36 in = 914 mm Q1908A (AEN)

Colorfast Adhesive Vinyl 328 40 ft = 12.2 m 36 in = 914 mm C6775A

Banner and Sign Material

Durable Display Film 205 50 ft = 15.2 m 36 in = 914 mm Q6620A (EN)

Instant-dry Gloss Indoor Banner 195 50 ft = 15.2 m 36 in = 914 mm Q5482A (N)

42 in = 1067 mm Q5483A (N)

Opaque Scrim 460 50 ft = 15.2 m 24 in = 610 mm Q8675A (N)

36 in = 914 mm Q1898B (AEN)

42 in = 1067 mm Q1899B (AEN)

Matte Polypropylene 130 75 ft = 22.9 m 36 in = 914 mm Q1903A (AEN)

42 in = 1067 mm Q1904A (AEN)

Banners with Tyvek® 140 50 ft = 15.2 m 36 in = 914 mm C6787A (AJN)

Outdoor Paper 145 100 ft = 30.5 m 36 in = 914 mm Q1730A (EN)

Blue Back Outdoor Billboard Paper 140 100 ft = 30.5 m 36 in = 914 mm C7949A (EN)

PVC-free Banner 410 100 ft = 30.5 m 36 in = 914 mm CG815A (EN)

42 in = 1067 mm CG816A (EN)

Fabric/Textile Material

Durable Flag Fabric 110 33 ft = 10.1 m 36 in = 914 mm Q6624A (EN)

Paper-backed Polyester Fabric 110 33 ft = 10.1 m 36 in = 914 mm Q1745A (E)

Paper-backed Satin Fabric Silk

(with backing)

63.5

160

100 ft = 30.5 m 36 in = 914 mm Q1748A (EN)

Table 10-3  Roll paper (continued)
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Paper type g/m² Length Width Part numbers

Fine Art Printing Material

Hahnemühle Smooth Fine Art Paper 265 35 ft = 10.7 m 24 in = 610 mm Q8732A (EN)

36 in = 914 mm Q8745A (EN)

42 in = 1067 mm Q8733A (EN)

310 35 ft = 10.7 m 24 in = 610 mm Q8734A (EN)

42 in = 1067 mm Q8735A (EN)

Hahnemühle Textured Fine Art
Paper

265 35 ft = 10.7 m 24 in = 610 mm Q8736A (EN)

36 in = 914 mm Q8737A (EN)

42 in = 1067 mm Q8738A (EN)

310 35 ft = 10.7 m 24 in = 610 mm Q8739A (EN)

42 in = 1067 mm Q8740A (EN)

Hahnemühle Watercolor Paper 210 38 ft = 11.6 m 36 in = 914 mm Q1984A (EN)

Baryte Satin Art Paper 290 50 ft = 15.2 m 24 in = 610 mm CG803A (EN)

44 in = 1118 mm CG804A (EN)

Aquarella Art Paper 240 35 ft = 10.7 m 24 in = 610 mm Q8741A (EN)

36 in = 914 mm Q8746A (EN)

Matte Litho-realistic Paper 270 100 ft = 30.5 m 24 in = 610 mm Q7972A (ELN)

36 in = 914 mm Q7973A (ELN)

Canvas Paper 180 35 ft = 10.7 m 36 in = 914 mm Q1724A (AEN)

Professional Matte Canvas 430 20 ft = 6.1 m 24 in = 610 mm Q8673A (ELN)

50 ft = 15.2 m 36 in = 914 mm Q8761A (ELN)

42 in = 1067 mm Q8674A (ELN)

Collector Satin Canvas 400 20 ft = 6.1 m 24 in = 610 mm Q8708A

50 ft = 15.2 m 36 in = 914 mm Q8709A

42 in = 1067 mm Q8710A

Artist Matte Canvas 380 20 ft = 6.1 m 24 in = 610 mm Q8704A

50 ft = 15.2 m 36 in = 914 mm Q8705A

42 in = 1067 mm Q8706A

Universal Matte Canvas 350 20 ft = 6.1 m 24 in = 610 mm Q8712A

50 ft = 15.2 m 36 in = 914 mm Q8713A

42 in = 1067 mm Q8714A

Table 10-4  Sheet paper

Paper type g/m² Length Width Part numbers

Bond and Coated Paper

Inkjet Coated Paper 90 24 in = 610 mm 18 in = 457 mm Q1961A (AJEN)

36 in = 914 mm 24 in = 610 mm Q1962A (AJEN)

Table 10-3  Roll paper (continued)
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Paper type g/m² Length Width Part numbers

Photographic Paper

Professional Satin Photo Paper 300 19 in = 483 mm 13 in = 330 mm Q8839A

Matte Photo Paper 196 19 in = 483 mm 13 in = 330 mm Q5492A

Proofing Paper

Professional High-gloss Contract
Proofing Paper

200 19 in = 483 mm 13 in = 330 mm Q8662A (EN)

Professional Semi-gloss Contract
Proofing Paper

235 19 in = 483 mm 13 in = 330 mm Q7970A (EJN)

Premium Semi-gloss Proofing
Paper

240 19 in = 483 mm 13 in = 330 mm CG461A (E)

Matte Proofing Paper 146 19 in = 483 mm 13 in = 330 mm Q1967A (AEN)

Fine Art Printing Material

Hahnemühle Smooth Fine Art Paper 265 19 in = 483 mm 13 in = 330 mm Q8728A

Hahnemühle Watercolor Paper 210 19 in = 483 mm 13 in = 330 mm Q8729A

Aquarella Art Paper 240 19 in = 483 mm 13 in = 330 mm Q8730A

Artist Matte Canvas 380 19 in = 483 mm 13 in = 330 mm Q8731A

Non-recommended paper types
In many cases, paper types that HP does not support may nevertheless be compatible with your printer.
However, the following paper types are unlikely to give satisfactory results:

● Photo paper that swells

● Brochure paper

Order accessories
The following accessories can be ordered for your printer.

Name Product number

HP Designjet Z2100/Z3200 24 inch Stand (Asia only) Q6663A

HP Designjet Z2100/Z3200 24 inch Spindle Q6700A

HP Designjet Z2100/Z3200 44 inch Spindle Q6699A

HP Advanced Profiling Solution International Q6695A

HP Advanced Profiling Solution Asia Pacific Q6701A

HP Jetdirect 630n IPv6 Gigabit Print Server J7997G

HP Jetdirect 635n IPv6/IPsec Print Server J7961A, J7961G

Table 10-4  Sheet paper (continued)
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Introduction to the accessories
Stand

The printer stand is used to support the printer and the basket, which collects prints as they emerge
from the printer. The main alternative to the stand is to put the printer on a desk.

The stand is normally provided with the HP Designjet Z3200. However, the HP Designjet Z3200 24in is
sold in Asian countries without the stand, and so the stand for this printer is also available separately
as an accessory.

The height of the stand is 668 mm.

The weight of the stand is 12.22 kg (44 inch) or 10.12 kg (24 inch).

HP Advanced Profiling Solution
HP and GretagMacbeth have worked together to develop the HP Advanced Profiling Solution, powered
by GretagMacbeth™ technology, which takes advantage of the spectrophotometer built into the printer
to provide a revolutionary end-to-end calibrated ICC color workflow.

The HP Advanced Profiling Solution, tailored for HP printers, offers a powerful and automated, yet cost-
effective color management system with a fully streamlined workflow that allows you to avoid the cost,
hassle and delay of offline measurement devices. Together, GretagMacbeth and HP provide a new
experience to designers, photographers and other creative professionals, whereby they can generate
proofs and photo quality prints accurately and consistently.

The Advanced Profiling Solution includes:

● The HP Colorimeter monitor calibrator, with which you can accurately calibrate and profile all of
your monitors: LCD, CRT and laptop

● An ICC profiling and editing software application providing additional features and functionality
beyond those included in the HP Color Center

Using the Advanced Profiling Solution, you can:

● See matching colors on your screen and printed paper

● Generate color profiles for all your paper types, in RGB or CMYK

NOTE: CMYK profiles can be used only with RIP software that works in CMYK

● Edit your color profiles visually for maximum control

● Perform all operations easily using a step-by-step software interface—no extra manuals needed

The HP Advanced Profiling Solution is fully supported by HP, so you do not need to deal with various
support organizations from different companies.

For more information, see http://www.hp.com/go/z3200/solutions/.

Key features
The HP Advanced Profiling Solution lets you take control of your colors:

● Calibrate and profile all of your monitors—LCD, CRT and laptop

● Automated RGB profiling with HP software drivers to ensure accurate printing (photos, designs,
etc.)
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● Automated CMYK profiling when your printer is driven by a Raster Image Processor (RIP) for
accurate digital prints and proofs

● Easily and visually edit your profiles for ultimate color control
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11 Troubleshooting paper issues

● The paper cannot be loaded successfully

● The paper type is not in the driver

● The paper has jammed

● Prints do not fall neatly into the basket

● The sheet stays in the printer when the print has been completed

● The paper is cut when the print has been completed

● The cutter does not cut well

● The roll is loose on the spindle

● A strip stays on the output tray and generates jams

● Recalibrate the paper advance
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The paper cannot be loaded successfully
● Ensure no paper is loaded.

● Ensure the paper is far enough inside the printer; you should feel the printer grab the paper.

● Do not attempt to straighten the paper during the aligning process, unless instructed to do so by
the front-panel display. The printer automatically attempts to straighten the paper.

● The paper may be crumpled, or warped, or may have irregular edges.

Unsuccessful roll load
● If the paper does not load, the leading edge of the paper may not be straight or clean, and needs

to be trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary
even with a new roll of paper.

● Ensure the roll ends are tight against the spindle ends.

● Check that the spindle is correctly inserted.

● Check that the paper is correctly loaded on the spindle, and that it loads over the roll into the printer.

● Check that all roll stops have been removed.

● Check that the paper is wound tightly on the roll.

● Do not touch the roll or paper at during the alignment process.

If the paper has not been inserted straight, the front panel displays the following instructions.

1. When prompted by the front-panel display, lift the blue lever on the left. The printer attempts to
straighten the roll.

2. When prompted by the front-panel display, lower the blue lever. The printer checks the alignment.
If the roll is aligned, the printer measures the width and you are now ready to print.

If the roll is still not aligned, the front panel displays an error and instructions.

3. When prompted by the front-panel display, lift the blue lever on the left.

4. Rewind the roll from the end of the spindle until the edge is on the blue line.

5. Press OK, on the front panel.

6. When prompted by the front-panel display, lower the lever. The printer checks the alignment. If the
roll is aligned, the printer measures the width and you are now ready to print.

If the roll is still not aligned, the front panel displays an error and instructions to start again at step
three.

If you would like to start the load process again, cancel the process on the front panel and rewind
the roll from the end of the spindle until the edge is removed from the printer.

Unsuccessful sheet load
● Guide the sheet, especially thick papers, when the printer initially feeds the sheet.

● Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-
panel display. The printer automatically attempts to straighten the sheet.

● Preferably avoid using hand-cut sheets; if you need to use them, load them with the option Sheet,
without skew check.
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If the sheet is not caught by the printer, the front-panel display asks to push paper further into the printer,
and tries to feed the paper again.

If the sheet is caught by the printer but is not inserted straight, the front panel displays the following
instructions.

1. When prompted by the front-panel display, lift the blue lever on the left.

2. Adjust the sheet to align with the front and right side blue lines.

3. Once the sheet is aligned, press OK on the front panel.

4. When prompted by the front-panel display, lower the blue lever. The printer checks the alignment.
If the sheet is aligned, the printer measures the sheet and feeds it out the back into the roll feed.
You are now ready to print.

If the sheet is still not aligned, the front panel displays an error and instructions to start again.

If you would like to start the load process again, cancel the process on the front panel and the
printer ejects the sheet out the front.

Paper loading error messages
Here is a list of front-panel display messages related to paper loading, with the suggested corrective
action.

front-panel display message Suggested action

Paper incorrectly loaded. The paper has not been loaded correctly; the edge was not aligned with the load
guide. Lift the blue lever, remove paper, and lower lever.

Paper not found. During the paper load process the printer did not detect any paper. Ensure the paper
is fully inserted.

Paper loaded with too much skew. During the paper load process the printer detected that the paper had too much
skew. Follow the instructions on the front-panel display.

Paper too small. During the load process the printer detected that the paper is too narrow or too short
to be loaded in the printer. Press the Cancel key to stop the load process. See
Functional specifications on page 157.

Paper too big During the load process the printer has detected that the paper is either too wide or
too long (sheet only) to be loaded correctly. Press the Cancel key to stop the load
process. See Functional specifications on page 157.

Lever lifted. During the load process the blue lever was lifted. This prevents the printer from
loading the paper. Follow the instructions on the front-panel display.

The paper type is not in the driver
TIP: First check that your driver is up to date (see Update the software on page 99). The latest driver
may offer a longer list of paper types.

To work with a paper not in the driver, you can add new paper type to your driver, see To create your
own paper preset on page 36. Adding your paper type to the driver is recommended as it allows you to
store custom parameters, such as a profile, for your paper.
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Your new paper type must be based on an existing paper category. The available categories are:

● Bond and Coated Paper: Fiber-based, thin papers with a matte surface. These papers use matte
black ink, no gloss enhancer, relatively low ink limits and high carriage position.

● Photo Paper: Photo-base, relatively thick papers with variety of finishing from matte to satin to
glossy. These papers use photo black ink and gloss enhancer, with the exception of Photo Matte
Papers, relatively high ink limits and low carriage position, with the exception of Baryte and Photo
Matte Papers. Generally they will print with the starwheels up.

● Proofing Paper: A variety of papers from matte to satin and glossy used to simulate commercial
printing with high color accuracy requirements.

● Fine Art Material: Canvas, matte and paper-base photo materials used for high-quality fine art
printing. These papers use matte black ink and no gloss enhancer, with the exception of Canvas
Satin and Pearl papers, which use photo black and gloss enhancer. They all use high carriage
position with high ink limits.

● Film: Synthetic film-base materials that generally use photo black and no gloss enhancer, with
relatively low ink limits and high carriage position.

● Backlit: Synthetic translucent materials that use photo black and no gloss enhancer with high ink
limits, high carriage position and starwheels up.

Black ink is easily removed when touched
TIP: Handle prints with care, especially when they have just emerged from the printer.

It may be that your paper is incompatible with matte black ink. To use non-matte black ink, select paper
type Photo Paper > Gloss Photo Paper.

NOTE: When you select a different paper type, the colors of your print could change visibly.

After printing, the paper has wrinkles or there is too much ink
This happens when too much ink is used. To use less ink, select a thinner category. Matte paper
categories from thinnest to thickest are:

● Plain Paper

● Coated Paper

● Heavyweight Coated Paper

● Fine Art Paper

● Super Heavyweight Coated Paper

● Thick Fine Art Paper (>250 g/m2)

For other image quality problems, see Troubleshooting print-quality issues on page 120.
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The paper has jammed
When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display.

1. Power off the printer at the front panel and also switch it off at the rear.

2. Open the window.

3. Try to move the printhead carriage out of the way.

4. Lift the blue lever as far up as it will go.
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5. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

6. Standing behind the printer, rewind the roll or pull the cut sheet from the printer. If you cannot see
the paper, return to the front of the printer and remove it from the output tray.

CAUTION: Do not move the paper sideways, as it could damage the printer.

7. Carefully remove all small pieces of paper.

8. Lower the blue lever.
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9. Close transparent window.

10. Switch on the printer.

11. Reload the roll, or load a new sheet. See Load a roll into the printer on page 25 or Load a single
sheet on page 30.

NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the
procedure and carefully remove all pieces of paper.

Prints do not fall neatly into the basket
● Ensure the basket is correctly installed.

● Ensure the basket is open.

● Ensure the basket not full.

● Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll,
or remove prints manually as they are completed.

The sheet stays in the printer when the print has been
completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time
on page 40. If the paper is only partially ejected after the drying time, gently pull the sheet out of the
printer. If the automatic cutter is disabled, use the Form feed and cut key on the front panel, see Feed
and cut the paper on page 40.

The paper is cut when the print has been completed
By default the printer cuts the paper after the drying time has been completed, see Change the drying
time on page 40. You can disable the cutter, see Turn the automatic cutter on and off on page 40.

The cutter does not cut well
By default the printer is set to cut the paper automatically after the drying time has been completed.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any
obstacles.

If the cutter is turned off, the Form feed and cut key only advances the paper. Use this key to move the
print far enough out of the front of the printer, until it is convenient to manually cut with a straight edge
or scissors.
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The roll is loose on the spindle
The roll may need to be replaced or reloaded. If your roll has a three-inch cardboard core, ensure the
core adaptors supplied with the printer have been installed, see Load a roll onto the spindle
on page 23.

A strip stays on the output tray and generates jams
If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after a full-
bleed print or after the Form feed and cut key has been pressed, the cut strip remains in the output tray.
Only when the printer is not working, reach in the tray and remove the strip.

Recalibrate the paper advance
Accurate paper advance is important to image quality because it is part of controlling the proper
placement of dots on the paper. If the paper is not advanced the proper distance between printhead
passes, light or dark bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you
select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing.
However, if you are using custom paper or not satisfied with the default calibration of your paper, you
may need to recalibrate the rate at which the paper advances. See Troubleshooting print-quality
issues on page 120 for steps to determine if paper advance calibration will solve your issue.

You can check the paper advance calibration status of the currently loaded paper at any time by pressing
the View loaded paper key on the front panel. The status may be one of the following.

● DEFAULT: This status appears when loading an HP paper. HP papers in the Front Panel have
been optimized by default and unless you experience image quality problems in your printed image
such as banding or graininess it is not recommended to recalibrate the paper advance.

● RECOMMENDED: This status appears when a new paper is created. The paper advance values
for this paper are inherited from the family type. In these cases it is recommended you perform a
paper advance calibration to optimize the values.

● OK: This status indicates that the loaded paper has been calibrated before. However you may need
to repeat the calibration if you experience image quality problems such as banding or graininess
in your printed image.

NOTE: Whenever you update the printer’s firmware, the paper advance calibration values are
reset to the factory default, see Update the firmware on page 98.
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Recalibrating the paper advance procedure
If you are using a a transparent paper type, omit the first two steps below and advance to step 3.

1.
From the front panel, select the Image Quality Maintenance menu icon , then Calibrate paper
advance. The printer automatically recalibrates the paper advance and prints a paper advance
calibration image.

2. Wait until the front panel displays the status screen and re-print your print.

NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the
paper advance calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print continue using this calibration for your paper type. If you see
improvement in your print, continue with step 3. If you are dissatisfied with the recalibration, return
to the default calibration, see Return to default calibration on page 119.

3. If you would like to fine-tune the calibration or are using a transparent paper type, select the Image

Quality Maintenance menu icon , then Paper advance calibration > Adjust paper
advance.

4. Select the percentage of change from -100% to 100%. To correct light banding (light-colored
horizontal lines), decrease the percentage. To correct dark banding (dark-colored horizontal lines),
increase the percentage.

5. Press the OK key on the front panel, to save the value.

6. Wait until the front panel displays the status screen and re-print your print.

Return to default calibration
Returning to the default calibration sets all the corrections made by the paper advance calibration to
zero. To return to the default paper advance calibration value, you must reset the calibration.

1.
From the front panel, select the Image Quality Maintenance menu icon , then Paper advance
calibration > Reset paper advance

2. Wait until the front panel reports that the operation has completed successfully before pressing
the Back key to return to the main menu.
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12 Troubleshooting print-quality issues

● General advice

● Print quality troubleshooting wizard

● Horizontal lines across the image (banding)

● The whole image is blurry or grainy

● The paper is not flat

● The print is scuffed or scratched

● Ink marks on the paper

● Vertical dotted or dashed lines on the print

● Vertical continuous lines on the print

● Edges of objects are stepped or not sharp

● Edges of objects are darker than expected

● Bronzing

● Horizontal lines at the end of a cut sheet print

● Vertical lines of different colors

● White spots on the print

● Colors are inaccurate

● The image is incomplete (clipped at the bottom)

● The image is clipped

● Some objects are missing from the printed image

● Lines are too thick, too thin or missing

● Lines appear stepped or jagged

● Lines print double or in the wrong colors

● Lines are discontinuous

● Lines are blurred

● The Image Diagnostics Print

● If you still have a problem
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General advice
When you have any print-quality problem:

● To achieve the best performance from your printer, use only genuine manufacturer's supplies and
accessories, whose reliability and performance have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended papers, see Order paper
on page 103.

● Make sure that the paper type selected in the front panel is the same as the paper type loaded into
the printer. To check this, use the View loaded paper key on the front panel. At the same time,
check that the paper type has been calibrated. Also make sure that the paper type selected in your
software is the same as the paper type loaded into the printer.

CAUTION: If you have the wrong paper type selected, you could experience poor print quality
and incorrect colors, and perhaps even damage to the printheads.

● Check that you are using the most appropriate print-quality settings for your purposes (see
Printing on page 42). You are likely to see lower print quality if you have moved the print-quality
slider to the 'Speed' end of the scale, or set the custom quality level to Fast.

● Check that your environmental conditions (temperature, humidity) are in the recommended range.
See Environmental specifications on page 159.

● Check that your ink cartridges and printheads have not passed their expiration dates: see Maintain
the ink cartridges on page 97.

● Avoid touching the paper while printing is in progress.

Print quality troubleshooting wizard
The Print Quality Troubleshooting Wizard can help with the following problems:

● Horizontal lines across the image (banding)

● The whole image is blurry or grainy

● Lines are too thick, too thin or missing

● Colors are inaccurate

To start the wizard:

● From the HP Printer Utility for Windows: go to the Support tab, and select Print quality
troubleshooting.

● From the HP Printer Utility for Mac OS: select Print quality troubleshooting in the Support
group.

● From the Mac OS Print dialog: go to the Services panel, select Device Maintenance, then
select Print quality troubleshooting from the list of maintenance tasks.

● From the Embedded Web Server: go to the Support tab, select Troubleshooting, then select
Print quality troubleshooting.
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Alternatively, or if you have other print quality problems, you can continue reading this chapter.

Horizontal lines across the image (banding)
If your printed image suffers from added horizontal lines as shown (the color may vary):

1. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing
on page 42). In some cases, you can overcome a print-quality problem merely by selecting a higher
print-quality level. For instance, if you have set the Print Quality slider to Speed, try setting it to
Quality; if you have already set it to Quality, try selecting custom options and then More
Passes. If you change the print-quality settings, you may wish to reprint your job at this point in
case the problem has been solved.

3. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 133.

4. If the printheads are working correctly, go to the front panel and press the View loaded paper key
to see the paper advance calibration status. If the status is RECOMMENDED, you should perform
paper advance calibration: see Recalibrate the paper advance on page 118.

If the problem persists despite all the above actions, contact your customer service representative for
further support.
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The whole image is blurry or grainy

1. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 42). In some
cases, you can overcome a print-quality problem merely by selecting a higher print-quality level.
For instance, if you have set the Print Quality slider to Speed, try setting it to Quality; if you have
already set it to Quality, try selecting custom options and then More Passes. If you change the
print-quality settings, you may wish to reprint your job at this point in case the problem has been
solved.

4. If you are using gloss enhancer, you can reduce grain by turning off or reducing the amount of
gloss enhancer; see If you are printing on photo paper on page 48. This can reduce the gloss
quality of the image; if you notice any problem, see Bronzing on page 127.

5. Try aligning the printheads. See Align the printheads on page 142. After alignment, you may wish
to reprint your job in case the problem has been solved.

6. Go to the front panel and press the View loaded paper key to see the paper advance calibration
status. If the status is RECOMMENDED, you should perform paper advance calibration: see
Recalibrate the paper advance on page 118.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

The paper is not flat
If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely
to see defects in the printed image, such as vertical stripes. This can happen when you use thin paper
that becomes saturated with ink.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper, HP Super
Heavyweight Coated Paper or thicker Digital Fine Art papers.

The print is scuffed or scratched
The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object.
This is particularly noticeable on coated paper, matte proofing paper and fine art material.

Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after
printing, depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:

● Handle prints carefully.

● Avoid stacking prints on top of each other.

● Disable the automatic cutter before printing, so that the print will not fall into the basket. See Turn
the automatic cutter on and off on page 40. Alternatively, leave a sheet of paper in the basket so
that freshly printed sheets do not make direct contact with the basket.

Ink marks on the paper
This problem can occur for several different reasons.

Horizontal smears on the front of coated paper
If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the
printheads move over the paper, the printheads may come into contact with the paper and smear the
printed image. This problem is normally seen only on cut sheets of paper (not on roll paper).
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Whenever you notice this problem, cancel the printing job immediately. Press the Cancel key and also
cancel the job from your computer application. Soaked paper can damage the printheads.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

2. Use a recommended paper type (see Order paper on page 103) and the correct print settings.

3. If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may
affect performance.

4. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper, HP Super
Heavyweight Coated Paper or thicker Digital Fine Art papers.

5. Try to increase the margins by relocating the image to the center of the page using your software
application.

6. If you are using a glossy or satin paper type, try changing the definition of the thickness of the
paper. In the HP Printer Utility, go to the Color Center > Paper preset management > Change
printing properties. For custom papers that have been created with glossy or satin papers as a
base, it is possible to change the Paper thickness to Thick.

Ink marks on the back of the paper
This can happen after a lot of borderless printing, especially with non-standard paper sizes. Ink residues
on the platen are likely to mark the back of the paper.

Clean the platen with a soft cloth. Clean each rib separately without touching the foam between the ribs.

Vertical dotted or dashed lines on the print
The starwheels that assist in moving the paper may in some cases leave small, regularly spaced marks
on the print.

First check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

● Using the HP Printer Utility for Windows, select Color Center > Paper Preset Management >
Change Printing Properties.

● Using the HP Printer Utility for Mac OS, select HP Color Center > Paper Preset Management.
Select the paper type, then press the  button and select Change Printing Properties from the
popup menu.

Change the starwheels position from Down to Up. If the starwheels position was already Up, as it
normally is by default for glossy papers, try using a different paper type.
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NOTE: We recommend keeping the starwheels in the Down position by default for all non-glossy
paper types, for better print quality and paper control; change to the Up position only if this problem
occurs.

Vertical continuous lines on the print
When loading a thick single sheet using the rear tray, the plastic rollers may in some cases leave regular
thick stripes on the print.

To avoid this, try loading this kind of sheet using the roll load path instead of the rear tray. You can align
the sheet with the help of the black hub of the spindle. Remember to specify that you are loading a single
sheet even if you are using the roll load path.

Edges of objects are stepped or not sharp

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set
the print-quality slider to Quality in the driver dialog (Mac OS Print dialog), select the custom print-quality
options, and make sure that the More Passes and Maximum Detail options are turned off. See
Printing on page 42.

Edges of objects are darker than expected

If edges of objects seem darker than expected, and you have already set the print-quality slider to
Quality in the driver dialog (Mac OS Print dialog), select the custom print-quality options, and make
sure that the More Passes and Maximum Detail options are turned off. See Printing on page 42.
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Bronzing
If you are printing on photo paper in grayscale, and you experience a gloss differential problem when
fluorescent light is directly reflected towards you from the print, producing 'bronzed' reflections from the
ink, try one of the following:

● If using standard print quality options, ensure that the slider is set to Quality (see Select print
quality on page 43)

● If using custom print quality options, ensure that the Gloss enhancer option is set to Whole
page (see If you are printing on photo paper on page 48)

● Increase the amount of gloss enhancer used (see If you are printing on photo paper on page 48)

● Display the print vertically or behind glass

Horizontal lines at the end of a cut sheet print
This type of defect affects only the end of a print, within approximately 30 mm of the trailing edge of the
paper. You may see some very thin horizontal lines across the print.

To avoid this problem:

1. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 133.

2. Consider printing with roll paper.

3. Consider using larger margins around your image.

Vertical lines of different colors
If your print has vertical bands of different colors along it:

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight
Coated Paper and HP Super Heavyweight Paper. See Order paper on page 103.

2. Try using higher print-quality settings (see Printing on page 42). For instance, if you have set the
Print Quality slider to Speed, try setting it to Quality; if you have already set it to Quality, try
selecting custom options and then More Passes.

White spots on the print
You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating
material. To avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.

2. Always keep the cover of your printer closed.

3. Protect your paper rolls and sheets by storing them in bags or boxes.
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Colors are inaccurate

If the colors of your print do not match your expectations, try the following:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key. At the
same time, check the color calibration status. If the status is PENDING or OBSOLETE, you should
perform color calibration: see Color calibration on page 60. If you have made any changes, you
may wish to reprint your job in case the problem has been solved.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 42). If you have
selected the Speed or Fast options, you may not get the most accurate colors. If you change the
print-quality settings, you may wish to reprint your job at this point in case the problem has been
solved.

4. If you are using application-managed colors, check that the color profile you are using corresponds
to the selected paper type. If you have doubts about which color settings to use, see Color
management on page 53. If you need to create a color profile, see Color profiling on page 61.

5. If you select application-managed colors in your application and printer-managed colors in the
printer driver, your results will be wrong. You should manage colors in the application or in the
printer, but not in both.

6. If the problem consists of color differences between your print and your monitor, please follow the
instructions in the “How to calibrate your monitor” section of the HP Color Center. At this point, you
may wish to reprint your job in case the problem has been solved.

7. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 133.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Color accuracy using EPS or PDF images in page layout applications
Page layout applications such as Adobe InDesign and QuarkXPress do not support color management
of EPS, PDF or grayscale files.

If you have to use such files, try to ensure that the EPS, PDF or grayscale images are already in the
same color space that you intend to use later on in Adobe InDesign or QuarkXPress. For instance, if
your final goal is to print the job in a press that follows the SWOP standard, convert the image into SWOP
when you create it.
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The image is incomplete (clipped at the bottom)
● Did you press Cancel before all the data were received by the printer? If so, you have ended the

data transmission and will have to print the page again.

● The I/O timeout setting may be too short. This setting determines how long the printer waits for
the computer to send more data, before deciding that the job is finished. From the front panel,
increase the I/O timeout setting to a longer period and then send the print again. From the

Connectivity menu , select Advanced > Select I/O timeout.

● There may be a communications problem between your computer and the printer. Check your USB
or network cable.

● Check to make sure that your software settings are correct for your current page size (for example,
long-axis prints).

● If you are using network software, make sure it has not timed out.

The image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and
the printable area as understood by your software. You can often identify this kind of problem before
printing by previewing your print (see Preview a print on page 46).

● Check the actual printable area for the paper size you have loaded.

printable area = paper size – margins

● Check what your software understands to be the printable area (which it may call "printing area"
or "imageable area"). For example, some software applications assume standard printable areas
that are larger than those used in this printer.

● If you have defined a custom page size with very narrow margins, the printer may impose its own
minimal margins, clipping your image slightly. You may want to consider using a larger paper size,
or borderless printing (see Select margins options on page 44).

● If your image contains its own margins, you may be able to print it successfully by using the Clip
Contents by Margins option (see Select margins options on page 44).

● If you are trying to print a very long image on a roll, check that your software is capable of printing
an image of that size.

● You may have asked to rotate the page from portrait to landscape on a paper size that is not wide
enough.

● If necessary, reduce the size of the image or document in your software application, so it fits
between the margins.

There is another possible explanation for a clipped image. Some applications, such as Adobe
Photoshop, Adobe Illustrator and CorelDRAW, use an internal 16-bit coordinate system which means
that they cannot handle an image of more than 32,768 pixels.

NOTE: An image 32,768 pixels long would print at a length of 54.61 in or 1.39 m if you select Best or
Quality in the driver, 109.23 in or 2.78 m if you select Fast, Normal or Speed in the driver.
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If you try to print an image larger than this from these applications, the bottom of the image may be
clipped. To print the whole image, try these suggestions:

● The Windows PCL3 driver dialog includes an option called Max. application resolution, which
enables you to print successfully in this situation. You will not normally need to change the default
setting, which is Auto. However, you can find the option in the Advanced tab, under Document
Options > Printer Features.

● Save the file in another format, such as TIFF or EPS, and open it with another application.

● Use a RIP to print the file.

Some objects are missing from the printed image
Large quantities of data may be necessary to print a high-quality large-format print job, and in some
specific workflows there may be issues that can lead to some objects missing from the output. Here are
some suggestions to help you to avoid this problem.

● Select a smaller page size and scale to the desired final page size in the driver or in the front panel.

● Save the file in another format, such as TIFF or EPS, and open it with another application.

● Use a RIP to print the file.

● Reduce the resolution of bitmap images in your application software.

● Select a lower print quality in order to reduce the resolution of the printed image.

● In the Advanced tab of the Windows driver dialog, select Document options, Printer features,
then set Max. application resolution to 300.

NOTE: The above settings are mentioned for troubleshooting purposes and may adversely affect
the final output quality or the time necessary to generate the print job. Therefore, they should be
restored to their default values if they do not help to solve the problem.

Lines are too thick, too thin or missing

1. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing
on page 42). Select the custom print-quality options in the driver dialog (Mac OS Print dialog), and
try turning on the Maximum detail option. You may wish to reprint your job at this point in case
the problem has been solved.

3. If lines are too thin or missing, print the Image Diagnostics Print. See The Image Diagnostics
Print on page 133.
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4. Try aligning the printheads. See Align the printheads on page 142. After alignment, you may wish
to reprint your job in case the problem has been solved.

5. Go to the front panel and press the View loaded paper key to see the paper advance calibration
status. If the status is RECOMMENDED, you should perform paper advance calibration: see
Recalibrate the paper advance on page 118.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Lines appear stepped or jagged
If lines in your image appear stepped or jagged when printed:

1. The problem may be inherent in the image. Try to improve the image with the application you are
using to edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 42.

3. Select the custom print-quality options in the driver dialog (Mac OS Print dialog), and turn on the
Maximum detail option.

4. Change your image rendering resolution to 300 ppi or 600 ppi depending on your printing needs.
You can find the Max. application resolution option in the Windows driver dialog's Advanced
tab, under Document Options > Printer Features.

Lines print double or in the wrong colors
This problem can have various visible symptoms:

● Colored lines are printed double, in different colors.
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● The borders of colored blocks are wrongly colored.

To correct this kind of problem:

1. Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 86 and Insert a printhead on page 88.

2. Align the printheads. See Align the printheads on page 142.

Lines are discontinuous
If your lines are broken in the following way:

1. Check that you are using appropriate print-quality settings. See Printing on page 42.

2. Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 86 and Insert a printhead on page 88.

3. Align the printheads. See Align the printheads on page 142.
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Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality
printing. See Environmental specifications on page 159.

2. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

3. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper, HP Super
Heavyweight Coated Paper or Digital Fine Art paper.

4. If you are using glossy paper, try changing to a different type of glossy paper.

5. Select the custom print-quality options in the driver dialog (Mac OS Print dialog), and turn on the
More passes option.

6. Align the printheads. See Align the printheads on page 142.

The Image Diagnostics Print
The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It
helps you to check the performance of the printheads that are currently installed in your printer, and
whether any printhead suffers from clogging or other problems.

To print the Image Diagnostics Print:

1. Use the same paper type that you were using when you detected a problem.

2. Use the View loaded paper key on the front panel to check that the selected paper type is the same
as the paper type loaded into the printer.

3.
At the printer's front panel, select the Image Quality Maintenance menu icon , then Print
diagnostic image.

It takes about two minutes to print the Image Diagnostics Print.

The print is divided into two parts, both of which test printhead performance.

● Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the
print quality that you will get from each color.

● Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part
complements the first, and aims more specifically to detect how many faulty nozzles each printhead
has.
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Please look carefully at the print. The names of the colors are shown above the rectangles and in the
center of the patterns of dashes.

First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without
any horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most
of the dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead
responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing
dashes in part 2; these are acceptable because the printer can compensate for a few clogged nozzles.

Here is an example of a light gray printhead in a good state:
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And here is an example of the same printhead in a bad state:

The gloss enhancer (E) cannot be seen when printed on its own, because it is a clear fluid. To make it
visible in the Image Diagnostics Print, it is printed over gray ink (G).

● In part 1 (top), the gloss enhancer is seen as a slightly different gray inner section of a gray
rectangle. On some papers the inner section may look darker, on other papers it may look lighter.

● In part 2 (bottom), the small dashes of gloss enhancer, one for each nozzle of the printhead, are
seen as small lighter gray dashes on top of a gray area.

On most plain and coated papers the gloss enhancer can barely be seen, so such papers are not suitable
for troubleshooting the gloss enhancer.

Corrective action
1. Clean any faulty printheads (see Clean the printheads on page 139). Then reprint the Image

Diagnostics Print to see whether the problem has been solved.

2. If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see
whether the problem has been solved.

3. If the problem remains, consider cleaning your printheads manually (see Clean the printheads
on page 139). You could also try reprinting your current print job, in case it now prints satisfactorily.
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4. If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you
when this is necessary, but it may be worth trying even if the printer has not suggested it. See
Clean the printhead drop detector on page 140.

5. If the problem still remains, replace any persistently faulty printheads (see Handling ink cartridges
and printheads on page 81), or contact HP Support (see Contact HP Support on page 154).

If you still have a problem
If you still experience print-quality problems after applying the advice in this chapter, here are some
further things that you can do:

● Try using a higher print-quality option. See Printing on page 42.

● Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about
the problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can
be downloaded from http://www.hp.com/go/z3200/drivers/.

● If you are using a non-HP RIP, its settings may be incorrect. See the documentation that came with
the RIP.

● Check that your printer's firmware is up to date. See Update the firmware on page 98.

● Check that you have the right settings in your software application.
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13 Troubleshooting ink cartridge and
printhead issues

● Cannot insert an ink cartridge

● Ink cartridge status messages

● Cannot insert a printhead

● The front-panel display recommends reseating or replacing a printhead

● Clean the printheads

● Clean the printhead drop detector

● Align the printheads

● Printhead status messages
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Cannot insert an ink cartridge
1. Check that you have the correct type of cartridge (model number).

2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label
right-side up and readable.

CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages
These are the possible ink cartridge status messages:

● OK: The cartridge is working normally, with no known problems.

● Missing: There is no cartridge present, or it is not correctly connected to the printer.

● Low: The ink level is low.

● Very low: The ink level is very low.

● Empty: The cartridge is empty.

● Reseat: You are recommended to remove the cartridge and then reinsert it.

● Replace: You are recommended to replace the cartridge with a new cartridge of the correct type
for your printer.

● Altered: There is something unexpected about the cartridge's status.

● Expired: It is past the cartridge's expiration date.

Cannot insert a printhead
1. Check that you have the correct type of printhead (model number).

2. Check that you have removed the two orange protective caps from the printhead.

3. Check that the colored label on the printhead is the same color as the label on the slot.

4. Check that the printhead is correctly oriented (compare with the others).

5. Check that you have correctly closed and latched the carriage lid, see Insert a printhead
on page 88.
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The front-panel display recommends reseating or
replacing a printhead

1. From the front panel, turn the power off then on.

2. Check the front-panel display message, if it shows the ready message, the printer is ready to print.
If the problem remains continue with the next step.

3. Remove the printhead, see Remove a printhead on page 86.

4. Clean the electrical connections on the backside of the printhead with a lint-free cloth. You can
carefully use de-ionized or distilled water if moisture is needed to remove residue. Do not use water.

CAUTION: This is a delicate process and may damage the printhead. Do not touch the nozzles
on the bottom side of the printhead.

5. Reinsert the printhead, see Insert a printhead on page 88.

6. Check the front-panel display message. If the problem remains, try a new printhead.

Clean the printheads
As long as the printer is kept turned on, an automatic cleaning is performed periodically. This ensures
there is fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy. If you have
not already done so, please see The Image Diagnostics Print on page 133 before proceeding.

To clean the printheads, go to the front panel and select the Image Quality Maintenance menu icon

, then Clean printheads. If you have gone through the Image Quality Diagnostic print process, you
know which colors are failing. Select to the pair of printheads which contain the failing colors. If you are
not sure which colors to clean, you can also select to clean all printheads. Cleaning all printheads takes
about 12 minutes. Cleaning a single pair of printheads takes about six minutes.

NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

If you have cleaned the printheads using the Clean printheads procedure from the front panel and are
still experiencing image quality problems, you can try cleaning the printhead nozzles manually using the
following procedure.

CAUTION: This is a delicate process and may damage the printhead. Do not touch the electrical
connections on the backside of the printhead.

First, remove the printhead (see Remove a printhead on page 86) and then use a lint-free cloth to clean
the bottom of the printhead until the residue is removed.
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Clean the printhead drop detector
The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in
order to substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces, block
the sensor print quality is affected.

When the front panel displays a warning message that the clean process is needed, you are
recommended to clean the printhead drop detector. If you do not clean the printhead drop detector
immediately, the printer continues working normally, however, the front panel display continues to show
the warning.

TIP: Wear gloves to avoid getting ink on your hands.

1. Turn off the printer at the front panel.
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2. To avoid an electric shock, switch the printer off and unplugged it.

3. Open the transparent window.

4. Find the printhead drop detector beside the stored printhead carriage.

5. Remove any debris blocking the printhead drop detector.
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6. With a dry lint-free cloth, wipe the surface of the drop detector to remove any non-visible debris.

7. Close the window.

8. Plug in and switch on the printer.

9. Power the printer on at the front panel.

Align the printheads
Precise alignment between printheads is essential for accurate colors, smooth color transitions and
sharp edges in graphical elements. Your printer has an automatic printhead alignment process which
runs whenever a printhead has been accessed or replaced.

In cases where the paper has jammed, you have used a custom paper or are experiencing problems
with color accuracy (see Color management on page 53); you may need to align the printheads.
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NOTE: If the paper has jammed, it is recommended that you reinsert the printheads and initiate the

realignment procedure with the Image Quality Maintenance menu .

TIP: Photo paper is recommended for the best quality; plain, bond and thin coated papers provide
acceptable but marginal results.

Do not use transparent or semi-transparent paper to align the printheads.

Reinsert printheads procedure
1. If the realignment process is running and the wrong paper is loaded, press the Cancel key on the

front panel.

Do not print if the realignment process has been canceled. You can restart the alignment with the
Image Quality Maintenance menu procedure.

2. Load the paper you wish to use, see Paper handling on page 22. You can use a roll or cut sheet,
however, it must be A3 landscape or larger (420 by 297 mm). Photo paper is recommended for
the best results.

NOTE: If you are using an A3 cut sheet, ensure it is loaded so the larger side feeds into the
printer.

Do not use transparent or semi-transparent paper to align the printheads.

3. Remove and re-insert all the printheads, see Remove a printhead on page 86 and Insert a
printhead on page 88. This starts the printhead alignment procedure.

4. Ensure the transparent window is closed, as a strong light source near the printer during printhead
realignment can affect alignment.

5. The process takes about six minutes. Wait until the front-panel display shows the process complete
before using the printer.

NOTE: The printer prints a calibration image. Do not worry about the image. The front-panel
display shows any errors in the process.

Image Quality Maintenance menu procedure
1. Load the paper you wish to use, see Paper handling on page 22. You can use a roll or cut sheet,

however, it must be A3 landscape or larger (420 by 297 mm). Photo paper is recommended for
the best results; plain, bond and thin coated papers provide acceptable but marginal results.

NOTE: If you are using an A3 cut sheet, ensure it is loaded so the larger side feeds into the
printer.

Do not use transparent or semi-transparent paper to align the printheads.

2.
From the front panel, select the Image Quality Maintenance menu icon , then Align
printheads. The printer checks to see if it has enough paper to run the realignment.
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3. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.
Ensure the transparent window is closed, as a strong light source near the printer during printhead
realignment can affect alignment.

4. The process takes about six minutes. Wait until the front-panel display shows the process complete
before using the printer.

Scanning errors during alignment
If the alignment process fails, a 'Scanning problems' message appears on the front panel. This means
that the alignment has not completed successfully. Therefore the printer is not aligned and the alignment
should be repeated before printing with good image quality. The problem may be due to:

● The paper used was not valid, repeat the alignment with valid paper

● Printhead health problems, clean printheads, see Clean the printheads on page 139

● The alignment was done with the transparent window open, repeat the alignment with the window
closed

If the problem persists after using valid paper, cleaning the printheads and keeping the window closed,
there may be a failure in the scanning system needing reparation or the printheads, although clean, may
not work and need to be replaced.

Printhead status messages
These are the possible printhead status messages:

● OK: The printhead is working normally, with no known problems

● Missing: There is no printhead present, or it is not correctly installed in the printer.

● Test printhead separately: You are recommended to test the printheads individually to find the
failing printhead. Remove all the printheads and insert them alone one by one, closing the latch
and the carriage lid after every insertion. The front-panel display indicates the failing one showing
the reseat or replace message.

● Reseat: You are recommended to remove the printhead and then reinsert it. If that fails, clean the
electrical connections, see The front-panel display recommends reseating or replacing a
printhead on page 139. If that fails, replace the printhead with a new printhead, see Remove a
printhead on page 86 and Insert a printhead on page 88.

● Replace: The printhead is failing. Replace the printhead with a working printhead of the correct
type for your printer, see Remove a printhead on page 86 and Insert a printhead on page 88.

● Replacement incomplete: A printhead replacement process has not completed successfully, re-
launch the replacement process and let it finish completely (it is not needed to change the
printheads).

● Remove: The printhead is not a suitable type for use in printing.
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14 Troubleshooting general printer issues

● The printer does not print

● The printer seems slow

● Communication failures between computer and printer

● Cannot access the HP Printer Utility

● Some Color Center options are unavailable

● Cannot access the Embedded Web Server

● Automatic file system check

● No output when printing from Microsoft Visio 2003

● Unavailable driver features when printing from QuarkXPress

● Printer alerts

ENWW 145

G
en

er
al

 p
rin

te
r i

ss
ue

s



The printer does not print
If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons
why a file you have sent from your computer may not start printing when expected:

● You may have an electrical power problem. If there is no activity at all from the printer, and the front
panel does not respond, check that the power cable is connected correctly and that there is power
available at the socket.

● You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic
fields or severe electrical disturbances, which can cause the printer to behave strangely or even
stop working. In this case, turn off the printer using the Power key on the front panel and unplug
the power cord, wait until the electromagnetic environment has returned to normal, then turn it on
again. If you still experience problems, please contact your customer service representative.

● You may not have installed in your computer the correct driver for your printer; see the Assembly
instructions.

● If you are printing on a sheet, you should specify sheet as the paper source.

● You may have requested a print preview from your printer driver. This is a function you can use to
check that the image is the one you want. In this case, the preview is displayed on your screen,
and you must click the Print button to start printing.

The printer seems slow
Here are some possible explanations.

● Did you set the print quality to Best or Max Detail? Best-quality and maximum detail prints take
longer as they require more passes.

● Did you specify the correct paper type when loading the paper? Photo and coated papers require
more drying time between passes. To find out the printer's current paper type setting, see View
information about the paper on page 34. Some paper types require more time for printing.

● Do you have a network connection to your printer? Check that all components used in the network
(network interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is
there a lot of traffic from other devices on the network?

● Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal.

Communication failures between computer and printer
Some symptoms are:

● The front-panel display does not show the Receiving message when you have sent an image to
the printer.

● Your computer displays an error message when you are trying to print.

● Your computer or printer hangs (stays idle), while communication is taking place.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics, etc.).

To solve a communication problem:

● Ensure that you have selected the correct printer in your application, see Printing on page 42.

● Ensure that the printer works correctly when printing from other applications.

● Remember that very large prints may take some time to receive, process and print.
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● If the printer is connected to a network, try using it when connected directly to your computer
through a USB cable.

● If your printer is connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected directly to
your computer.

● Try another interface cable.

● If the printer is connected with a USB, try to disconnect and reconnect the USB cable with the
computer. Check that the USB cable is of good quality.

Cannot access the HP Printer Utility
If you have not done so already, please read Access the HP Printer Utility on page 19.

1.
From the front panel, select the Connectivity menu icon .

2. Select Advanced > Web Services > Printer Utility Software > Enable.

3.
If you have a TCP/IP connection to your printer, select the Connectivity menu icon  again.

4. Select the type of connection you are using.

5. Select View Information and check that the printer has IP enabled and a valid IP address.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Some Color Center options are unavailable
If you see that some options are unavailable in the Color Center under Mac OS, this could be because
you did not install the printer queue to print to that printer, but searched for the printer directly in the HP
Printer Utility Printer Selector Screen, by going to More Printers or Add Manually.

If this is the case, you will see a green circle in the Printer Selector beside the name of your printer. If
you see a green small house, then the printer is correctly configured to print and all options will be
available.

Cannot access the Embedded Web Server
If you have not done so already, please read Access the Embedded Web Server on page 19.

NOTE: If you connect directly to your printer with a USB cable, use the HP Printer Utility.

1.
From the front panel, select the Connectivity menu icon .

2. Select Advanced > Allow EWS > On.

3.
If you have a TCP/IP connection to your printer, select the Connectivity menu icon  again.

4. Select the type of connection you are using.

5. Select View Information.

6. Ensure that you see IP enabled. If not, you may need to use a different connection.
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If you are using a proxy server, try bypassing the server and accessing the Web server directly.

● In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and check the Bypass proxy server for local addresses box. Alternatively, for more
precise control, click the Advanced button and add the printer's IP address to the list of exceptions,
for which the proxy server is not used.

● In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change
Settings button. Add the printer's IP address or its domain name to the list of exceptions, for which
the proxy server is not used.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Automatic file system check
When you turn on the printer, you will occasionally see a front panel display similar to the one shown
below.

A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

CAUTION: If you turn the printer off before the file system check has finished, the file system could
be seriously damaged, making the printer's hard disk unusable. In any case, the file system check will
restart from the beginning whenever you turn the printer on again.

A file system check is scheduled every 90 days, in order to maintain the hard disk's file system integrity.

No output when printing from Microsoft Visio 2003
For more information about problems when printing large images (more than 129 inches long) from
Microsoft Visio 2003, see Microsoft's online knowledge base (http://support.microsoft.com/search/).

To avoid these problems, it is possible to scale the image down in Visio to a size shorter than 129 inches
and then to scale the drawing up in the driver by using the Scale to options in the Effects tab of the
Windows driver. If the down-scaling in the application and the up-scaling in the driver match, the result
is as originally intended.

Unavailable driver features when printing from
QuarkXPress 

When you print from QuarkXPress, the following driver features are not available.

● Print Preview

● Rotation

● Scaling
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● Office features or paper saving options

● Back to front printing

To get the same results, use the equivalent features available in QuarkXPress.

Printer alerts
Your printer can communicate are two types of alerts:

● Errors: Mainly alerting you to the fact that the printer is unable to print. However, in the driver,
errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer
is able to print.

● Warnings: Alert you when the printer needs attention either for an adjustment, such a calibration
or for a possible unprintable situation, such a preventive maintenance or low ink.

There are three different alerts communicators within your printer's system.

● Embedded Web Server: The upper-right corner of the EWS screen shows the Printer status. If
there is an alert in the printer, the status shows the alert text. Both the front-panel display and the
EWS show the same alert.

● Driver: The driver shows alerts. The driver warns about job configuration settings that may produce
a problem in the final output. If the printer is not ready to print, it displays a warning.

● HP Printer Utility: In the HP Printer Utility for Windows, alerts are displayed in the Items needing
attention pane in the Overview tab. In the HP Printer Utility for Mac OS, alerts are displayed at
the bottom of the HP Printer Monitor panel. In these areas you can find the following:

◦ Printer status

◦ Alerts when the printer cannot print a job

◦ Print-quality and general troubleshooting links

◦ Firmware update notices

◦ Maintenance tools, like color calibration

◦ Access to the job accounting and printer usage information

◦ Access to some printer settings as well as the network settings.

By default alerts are only displayed when you are printing and there are printing problems. For
example: cartridge low or out of ink or printer out of paper. If alerts are enabled and there is a
problem that prevents printing, you see a pop-up window, which explains why the printer is not
going to print. Follow the on-screen instructions to achieve your required result.

You can configure these alerts as desktop alerts as well.

◦ Using the HP Printer Utility for Windows, alert settings can be accessed from the Overview
tab, from the Support tab and from Tools. There is also an Alert Settings link in each alert
dialog box. Alerts can be completely disabled by setting them to Off in the Alert Settings
window. You can choose to receive alerts only when printing to the printer (default) or any
time a problem occurs. You can also set the alert method: pop-up dialog (default) or desktop
alert.

◦ Using the HP Printer Utility for Mac OS, alert settings can be accessed by selecting HP Printer
Monitor > Preferences > Notification.
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15 Front-panel error messages

Occasionally you may see one of the following messages appear on the front-panel display. If so, please
follow the advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response,
contact HP Support. See Contact HP Support on page 154.

Table 15-1  Text messages

Message Recommendation

[Color] cartridge has expired Replace the cartridge. See Handling ink cartridges and
printheads on page 81.

[Color] cartridge is missing Insert a cartridge of the correct color. See Handling ink
cartridges and printheads on page 81.

[Color] cartridge is out of ink Replace the cartridge. See Handling ink cartridges and
printheads on page 81.

[Color] printhead #[n] error: not present Insert the correct printhead. See Handling ink cartridges and
printheads on page 81.

[Color] printhead #[n] error: please remove Remove the incorrect printhead and insert a new printhead of
the correct type (color and number). See Handling ink
cartridges and printheads on page 81.

[Color] printhead #[n] error: replace Remove the non-functional printhead and insert a new
printhead. See Handling ink cartridges and printheads
on page 81.

[Color] printhead #[n] error: reseat Remove and reinsert the same printhead, or try cleaning the
electrical connections. If necessary, insert a new printhead.
See The front-panel display recommends reseating or
replacing a printhead on page 139.

[Color] printhead #[n] out of warranty The printhead's warranty has ended, because of the length of
time it has been in operation or because of the volume of ink
used. See Legal Information.

[Color] printhead #[n] warranty warning The printhead's warranty may be invalidated by the use of the
wrong kind of ink. See Legal Information.

IO error Restart the printer. If the problem persists, contact HP Support.
See Contact HP Support on page 154.

IO warning Try again; if the problem persists, contact HP Support. See
Contact HP Support on page 154.

Paper advance calibration pending Perform paper advance calibration. See Recalibrate the paper
advance on page 118.

Paper too small to print paper advance calibration Unload paper and load larger paper.

Paper too small to scan paper advance calibration Unload paper and load larger paper.

Printhead alignment error: paper too small Unload paper and load larger paper.
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Message Recommendation

Replace [color] cartridge Replace the cartridge. See Handling ink cartridges and
printheads on page 81.

Reseat [color] cartridge Remove and reinsert the same cartridge. See Handling ink
cartridges and printheads on page 81.

Update: failed. Invalid file Make sure that you have selected the correct firmware update
file. Then try again to perform the update.

Table 15-2  Numerical error codes

Error code Recommendation

52:01 The printer needs internal cleaning. See Clean the printhead drop detector on page 140. If the
problem persists, contact HP Support. See Contact HP Support on page 154.

61:01 The file format is wrong and the printer cannot process the job. The printer expects jobs to be
sent in PCL3 format.

62, 63, 64, 65, 67 Check that the printer cables are well connected and the USB cable is of good quality. Try again
to print the same file. Make sure you are using the correct driver for your printer. Update your
printer's firmware. See Update the firmware on page 98.

74.1 Try the firmware update again. If possible, try to update over a network if the USB update failed.
Do not try to use your computer while the update is in progress. If the problem persists, contact
HP Support. See Contact HP Support on page 154.

75 A printer maintenance kit is required. See Printer maintenance kits on page 99.

78 You may be trying to print borderless on a paper type that does not support it. See Print with
no margins on page 49.

79 Restart the printer. If the problem persists, update your printer's firmware. See Update the
firmware on page 98. If the problem still persists, contact HP Support. See Contact HP
Support on page 154.

81, 86, 87 There may be a paper jam. See The paper has jammed on page 115. If the problem persists,
contact HP Support. See Contact HP Support on page 154.

94, 94.1 Restart color calibration. See Color calibration on page 60.

98 There may be a printhead problem. See Troubleshooting ink cartridge and printhead issues
on page 137.

any other codes Restart the printer. If the problem persists, contact HP Support. See Contact HP Support
on page 154.

Table 15-1  Text messages (continued)
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16 HP Customer Care

● Introduction

● HP Professional Graphics Services

● HP Proactive Support

● Contact HP Support
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Introduction
HP Customer Care offers award-winning support to ensure you get the most from your HP Designjet,
providing comprehensive, proven support expertise and new technologies to give you unique end-to-
end support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair
and exchange services, phone and Web support, software updates and self-maintenance services. To
find out more about HP Customer Care, please visit us at:

http://www.hp.com/go/graphic-arts/

or call us on the telephone (see Contact HP Support on page 154). To register your warranty:

http://register.hp.com/

HP Professional Graphics Services
For further information on all the services described in this section, please visit http://www.hp.com/go/
pgs/.

Knowledge Center
Enjoy a world of dedicated services and resources to ensure you always get the best performance from
your HP Designjet products and solutions.

Join the HP community at the Knowledge Center, your large-format printing community at
http://www.hp.com/go/z3200/knowledgecenter/ for 24×7 access to:

● Multimedia tutorials

● Step-by-step how-to guides

● Downloads — the latest printer firmware, drivers, software, paper presets, etc.

● Technical support — online troubleshooting, customer care contacts and more

● Workflows and detailed advice for completing various printing tasks from particular software
applications

● Forums for direct contact with the experts, both HP and your colleagues

● Warranty tracking online, for your peace of mind

● Latest product information — printers, supplies, accessories, software, etc.

● Supplies Center for all you need to know about ink and paper

By customizing your registration for the products you have purchased and your type of business, and
by setting your communication preferences, you decide the information you need.

HP Start-Up Kit
The HP Start-Up Kit is the CD that comes with your printer; it contains the printer's software.

HP Care Packs and Warranty Extensions
If you would like to extend your printer's warranty beyond the standard period, two methods are available.

● An HP Care Pack provides support for a three-year period. You can buy it when you buy the printer,
or for a short time afterwards.

● A one-year Warranty Extension can be bought at any time.
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HP Care Packs and Warranty Extensions include remote support. On-site service is also provided if
necessary, with two alternative response-time options.

● Next business day

● Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit http://www.hp.com/go/lookuptool/.

HP Installation
The HP Installation service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, please visit http://www.hp.com/go/
lookuptool/.

HP Proactive Support
HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing and
resolving printer issues before they become problems for you. HP's Proactive Support tool is designed
to help businesses of all sizes reduce support costs and maximize productivity—all with the click of a
mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control
of your printing environment—with a clear focus on maximizing the value of your investment, increasing
printer uptime and reducing printer management costs.

HP recommends that you enable Proactive Support right away to save you time and prevent problems
before they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for
software and firmware updates.

You can enable Proactive Support in the HP Printer Utility, where you can specify the frequency of
connections between your computer and HP's Web server, and the frequency of diagnostic checks. You
can also choose to run the diagnostic checks at any time.

● Under Windows, there are two ways of accessing HP Proactive Support from the HP Printer Utility.

◦ Select Tools > HP Proactive Support.

◦ Click near the bottom of the window where you see the text HP Proactive Support is
disabled on your system.

● Under Mac OS, select Information > Printer Status > Printer Details. The HP Printer Monitor
will open. Select Preferences > Monitoring > HP Proactive Support.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the
problem and recommend a solution. In some cases, the solution may be applied automatically; in other
cases, you may be asked to perform some procedure to solve the problem.

See also Access the HP Printer Utility on page 19.

Contact HP Support
HP Support is available to you by telephone. What to do before you call:

● Review the troubleshooting suggestions in this guide.

● Review the relevant driver documentation.
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● If you have installed third-party software drivers and RIPs, see their documentation.

● If you call one of the Hewlett-Packard offices, please have the following information available to
help us answer your questions more quickly:

◦ The printer you are using (the product number and the serial number, found on the label at
the back of the printer)

◦ If there is an error code on the front panel, note it down; see Front-panel error messages
on page 150

◦
The printer's Service ID: at the front panel, select the Information menu icon , then View
printer information

◦ The computer you are using

◦ Any special equipment or software you are using (for example, spoolers, networks, switch-
boxes, modems or special software drivers)

◦ The cable you are using (by part number) and where you purchased it

◦ The type of interface used on your printer (USB or network)

◦ The software name and version you are currently using

◦ If possible, print out the following reports; you may be asked to fax them to the support center
helping you: Configuration, Usage Report and “all pages above” from Service Information
(see The printer's internal prints on page 7)

Telephone number
Your HP Support telephone number is available on the Web: please visit http://welcome.hp.com/country/
us/en/wwcontact_us.html.
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17 Printer specifications

● Functional specifications

● Physical specifications

● Memory specifications

● Power specifications

● Ecological specifications

● Environmental specifications

● Acoustic specifications
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Functional specifications
Table 17-1  HP 70 ink supplies

Printheads Two inks in each printhead: gloss enhancer and gray, blue and
green, magenta and yellow, light magenta and light cyan,
photo black and light gray, and matte black and red

Ink cartridges Cartridges containing 130 ml of ink: gloss enhancer, gray, blue,
green, magenta, yellow, light magenta, light cyan, photo black,
light gray, matte black, and red

Table 17-2  Paper sizes

Minimum Maximum

Roll width 11 inches (279 mm) 24-inch printer: 24 inches (609 mm)

44-inch printer: 44 inches (1118 mm)

Roll length 300 feet (91.4 m)

Sheet width 8.3 inches (210 mm, A4 Portrait) 24-inch printer: 24 inches (609 mm)

44-inch printer: 44 inches (1118 mm)

Sheet length 11 inches (279 mm, Letter Portrait) 24-inch printer: 36 inches (915 mm)

44-inch printer: 66 inches (1676 mm)

Table 17-3  Printing resolutions

Print
quality

Maximum
detail

Extra
passes

Rendering resolution
(ppi)

Printing resolution (dpi)

Best On

On

Off

Off

On

Off

On

Off

600 × 600

600 × 600

600 × 600

600 × 600

2400 × 1200 (glossy & satin paper only)

1200 × 1200

1200 × 1200

1200 × 1200

Normal On

Off

Off

 600 × 600

600 × 600

300 × 300

1200 × 1200

1200 × 1200

1200 × 1200

Fast On

Off

Off

 600 × 600

600 × 600

300 × 300

1200 × 1200

1200 × 1200

1200 × 1200

Table 17-4  Margins 

Top right and left margins 5 mm = 0.2 inches

Bottom margin (trailing edge) 5 mm = 0.2 inches (roll)

17 mm = 0.67 inches (sheet)

NOTE: Printing without margins is possible with glossy and satin paper types.

ENWW Functional specifications 157

Sp
ec

ifi
ca

tio
ns



Table 17-5  Mechanical accuracy 

±0.2% of the specified vector length or ±0.3 mm (whichever is greater) at 23°C (73°F),  50-60% relative humidity, on E/A0
printing material in Best or Normal mode with HP Matte Film roll feed.

Table 17-6  Graphic languages supported

HP Designjet Z3200 Photo Printer HP-PCL3 GUI

Table 17-7  Operating systems supported

Apple Mac OS X 10.4 and later versions

Microsoft Windows XP and later versions

Physical specifications
Table 17-8  Printer physical specifications

 24 inch printer 24 inch printer (without stand) 44 inch printer

Weight 143 lb (65 kg) 103.6 lb (47 kg) 189 lb (86 kg)

Width 49.7 inches (1262 mm) 49.7 inches (1262 mm) 69.7 inches (1770 mm)

Depth Minimum: 26 inches (661 mm)

Maximum: 28.8 inches (732 mm)

Minimum: 26 inches (661 mm)

Maximum: 28.8 inches (732 mm)

Minimum: 26 inches (661 mm)

Maximum: 28.8 inches (732 mm)

Height 41.2 inches (1047 mm) 15.4 inches (391 mm) 41.2 inches (1047 mm)

Memory specifications
Table 17-9  Memory specifications

Memory (DRAM) supplied 256 MB

Hard disk 80 GB

Power specifications
Table 17-10  Printer power specifications

Source 100–240 V ac ±10%, auto-ranging

Frequency 50–60 Hz

Current < 2 A

Consumption < 200 W

Ecological specifications
For the up-to-date ecological specifications of your printer, please go to http://www.hp.com/ and search
for “ecological specifications”.
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Environmental specifications
Table 17-11  Printer environmental specifications

Temperature range Humidity range

Operating for optimal print quality 22°C to 26°C (72°F to 79°F) 30% to 60%

Operating for standard printing 15°C to 35°C (59°F to 95°F) 20% to 80%

Printer without consumables 5°C to 40°C (41°F to 104°F)

Non-operating packed consumables and
printer:

-40°C to 60°C (-40°F to 140°F)

Acoustic specifications
Printer acoustic specifications (declared according to ISO 9296).

Table 17-12  Printer acoustic specifications

Idle sound power level 4.4 B (A)

Operating sound power level 6.5 B (A)

Idle sound pressure at bystander position 29 dB (A)

Operating sound pressure at bystander position 49 dB (A)
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Glossary

AppleTalk A suite of protocols that Apple Computer developed in 1984 for computer networking, not supported
by this printer. Apple now recommends TCP/IP networking instead.

Bonjour Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a
computer network technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services
available on a local area network. It was originally known as Rendezvous.

Color accuracy The ability to print colors that match the original image as closely as possible, bearing in mind
that all devices have a limited color gamut and may not be physically capable of matching certain colors precisely.

Color consistency The ability to print the same colors from a particular print job from print to print and from
printer to printer.

Color model A system of representing colors by numbers, such as RGB or CMYK.

Color space A color model in which each color is represented by a specific set of numbers. Many different color
spaces can use the same color model: for instance, monitors generally use the RGB color model, but they have
different color spaces, because a particular set of RGB numbers results in different colors on different monitors.

Cutter A printer component that slides back and forth across the platen to cut the paper.

ESD ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door,
or the cling of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic
discharges are one of the main hazards to the electronics products. Therefore, to prevent damage some
precautions are needed when setting up the product, or handling ESD sensitive devices. This type of damage may
reduce the life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type
of damage is by touching any exposed grounded part of the product (mainly metal parts) before handling ESD
sensitive devices (such as the printheads or ink cartridges). Additionally, to reduce the generation of electrostatic
charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum when
handling ESD sensitive devices. Also, avoid working in low humidity environments.

Ethernet A popular computer networking technology for local area networks.

Firmware Software that controls your printer's functionality and is stored semi-permanently in the printer (it can
be updated).

Gamut The range of colors and density values reproducible on an output device, such as a printer or monitor.

Gloss enhancer A clear fluid that improves gloss uniformity and eliminates bronzing as an image quality issue
on photo papers. It is not used on matte papers.

I/O Input/Output: this term describes the passing of data between one device and another.

ICC The International Color Consortium, a group of companies that have agreed on a common standard for color
profiles.

Ink cartridge A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address A unique identifier that identifies a particular node on a TCP/IP network. It consists of four integers
separated by dots.
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Jetdirect HP's brand name for its series of print servers that allow a printer to be connected directly to a local
area network.

LED Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address Media Access Control address: a unique identifier used to identify a particular device on a network.
It is a lower-level identifier than the IP address. Thus, a device has both a MAC address and an IP address.

Nozzle One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which
are pulped, dried and pressed.

Paper preset  A specification of the characteristics and requirements of a particular paper type.

Platen The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead A removable printer component that takes ink of one or more colors from the corresponding ink
cartridge(s) and deposits it on the paper, through a cluster of nozzles. In the HP Designjet Z3200, each printhead
prints two different colors.

Rendezvous Apple Computer's original name for its networking software later known as Bonjour.

Spindle A rod that supports a roll of paper while it is being used for printing.

TCP/IP Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is
based.

USB Universal Serial Bus: a standard serial bus designed to connect devices to computers.

ENWW Glossary 161



Index

A
accessories

order 108
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B
banding problems 118
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output problems 117
battery change 99
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color 60
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clean the platen 125
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clipped at bottom 129
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color management process 59
color management scenarios 67
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configure 21
connect the printer
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Windows direct 11
Windows network 10
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core adaptors 24
cost accounting 80
create paper preset 36
create paper preset

(advanced) 37
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Customer Care 153
cutter

on/off 40
problems 117

cutter, replace 93

D
delete paper preset 35
disk erase, secure 99
documentation 2
draft printing 47
Driver features

QuarkXPress 148
drying time
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ecological specifications 158
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economize on paper 51
Embedded Web Server
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cannot access 147
ink and paper usage 79
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F
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firmware update 98
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adjust paper advance 119
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allow EWS 147
calibrate color 60
calibrate paper advance 119
clean printheads 139
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enable cutter 40
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internal prints 8
load roll 28
load sheet 32
modify configuration 21
move paper 39
print diagnostic image 133
printer utility software 147
printhead information 86
replace ink cartridges 83
replace printheads 86
reprint last job 49
reset cutter life counter 93
reset paper advance 119
rotate 50
select display contrast 21
select drying time 40
select I/O timeout 129
select language 19
select paper type 114
select units 21
sleep mode wait time 20
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view loaded paper 34
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graininess 123
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Solution 109
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HP Support 154
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specification 157
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Knowledge Center 153
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general advice 23
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M
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none 49
specification 157
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more passes 48
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O
operating systems 158
order
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page size 43
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feed and cut 40
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size 43
types 103
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paper not flat 123
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print job
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bottom of print 127
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